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Before You Start ...

If you have not done so already, we suggest you go to Manual I and read
Chapter 1, “Getting Started,” before beginning this tutorial. “Getting Started”
gives you important information about the system and how to use it.

Hardware Overview

The following diagram shows the hardware in a typical Synclavier system. Some
features are optional.

Superfloppy

Macintosh drive -
monitor ivi \ Fynclavrier 6400

Macintosh CPU \ <«—— System hard drive
= [] y

| _

O < Optical

" = = disk
Trackball _\I'a"l— 4| .............
oo e o e o BT, T =l =
!tr:r:l:h:l:l:h‘jﬁ&
Macintosh
keyboard
Velocity/pressure keyboard
Macintosh CPU All of our systems use a Macintosh computer as the major user

interface component. The CPU type can be one of the
Macintosh Il family or one of the Quadra series.

Macintosh monitor The software will run on many different types of monitors.
The minimum size supported is 16 inches. A color monitor is
recommended, and you can use two monitors if you need
additional screen space.

Synclavier [6400] This is the main computer manufactured by The Synclavier
Company. It can be a 3200, 6400 or 9600 model. The
differences between these models are in how many voices and
how much memory the systems can support.

Superfloppy drive A high-density, 5.25 inch floppy drive that is used to boot the
Synclavier system.

2 Before You Start...
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System hard drive An internal hard drive that contains all the system software for
the Synclavier. This drive is also used for data storage of
sounds and sequences.

Velocity/Pressure The keyboard can be used to create and edit sounds, and to
keyboard (optional) record musical sequences.

Optical disk drive The Synclavier Company supports two types of optical disk
(optional) drives: a WORM drive and a magneto optical. The optical

drive is used for on-line storage and archival of sound data.

Sound Design and Sequence Editing

The Synclavier is a powerful tool used to create and edit sound. All its displays and
features can be summarized by discussing two areas: sound design and sequence
editing.

Sound Design begins with two basic building blocks—

Sound files These sounds are recorded (sampled) with an analog-to-
digital converter (ADC) and stored in the computer in digital
format.

Synthesized waveforms  These sounds are generated internally by the FM synthesizer
module. Additive synthesis is a process in which simple sine
tones are superimposed on one another to create a complex
waveform. [Note: FM sounds are only available if you have
purchased the FM hardware.]

Beginning with sound files or synthesized waveforms (or both), you can layer up to four
different sounds to create a whole timbre (pronounced TAM-ber). Each layer, called a
partial timbre is a separate sound with its own harmonic structure and waveform,
volume level, tuning, and many other parameters that can be modified during the sound
design process. Once designed, these timbres can be named and saved in a timbre
directory.

A timbre can be as simple as one sound file, or one sine tone generated by the computer.
The partial timbre system, however, with its multiple layers of sounds and control
parameters, has the capability to create a number of rich and complex sounds that can be
saved and then further modified. Once you become familiar with the way timbres work,
you should be able to create appropriate sounds for any situation, whether it is music or
sound effects.

Before You Start... 3
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Software

Once a library of timbres has been designed (or sound files recorded), the timbres can be
placed into a sequence, which is a list of start and end times for audio events. Each
sequence can have many tracks. All the events on a single track are played with the
same timbre. When the sequence is started (played), up to 200 different tracks can be
heard simultaneously, each potentially with its own timbre. There are many features
provided for recording and editing the sequence, and for modifying each track
individually. Sequences can be named and saved as files, and recalled later for playback
or further modification.

The Synclavier is a powerful and flexible system for timbre and sequence design. The
user has a great deal of control over many different layers and organizations of sound
events.

Many of the sound design functions of the Synclavier are available from the RTP
displays. The Main Menu is a directory of all RTP screens. Depending on the
configuration of your system, you may or may not use all of the screens listed.

i Main Menu i
Directories Memory Recorder
5. ‘Sequence Editor
B. Sound File Directory G. Recorder Display
C. Sequence Directory H. Multichannel Disploy
D. Subcatalog Directory J. Midi Display
M. Missing Sound Disploy K. Music Notaotion Disploy
Sound Design Direct-To-Disk
L. Sound File Editor 0. Project Directory
F. FM Tinbre Display P. Track Display
1. Patch Display ). Audio Event Editor
N. Nome Keyboord Timbre
Sound Archival System Control
R. Optical Disk Storage E. Extra System Commands
<PF1> Reverse Compiler
<PF3> Music Printing
<PF1> SFM
<BREAK> Monitor
Release 3.2 Current Timbre:

Some Synclavier functions, such as recalling sound files, routing outputs and recording a
sequence are available from TransferMation. To access TransferMation from the RTP,
select TransferMation from the Window menu. This starts the TransferMation
application.

Windowr

Autoconform
TransfermMation™
K Panel

To go to an RTP display while in TransferMation, click in the RTP window, or select
NED StartUp from TransferMation’s Display menu.

4 Before You Start...
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The Synclavier Keyboard and VK Panel

The Synclavier keyboard is velocity and pressure sensitive so that you can control a
sound’s volume or quality by varying the sharpness of your keyboard attack or the
amount of after-touch pressure you apply to the keys.

The two wheels located at the left of the keyboard are used to change the pitch and
modulation of the sounds. The display window gives you messages. Turning the
control knob changes values in the display window; the further you turn it, the faster
the values change. The five button panels initiate Synclavier functions.

Drisplay window

Button pansk
Conlrol knok

\

Mod wheel Ribon controller
Pitch wheel

Yelciylpressurs senstive keys

The on-screen VK (Velocity Keyboard) Panel option allows you to simulate the actions of
a Synclavier button panel. You can use the VK Panel along with a MIDI keyboard
instead of the Synclavier keyboard. Instead of pushing the buttons on the keyboard, you
click buttons on the VK Panel. The control knob moves by dragging it with the cursor
left and right. To display the VK Panel, select VK Panel from the Window menu.

TIMERE PARAMETERS

— TRACKDGITAL | MEORY
PARTIAL TIMBRE LUME ENVELOPE. CONTROL.
et
B | dipe il e due dibe Bie | B 4 4 A - - T O T
2 | otiar wirack MTIAL AL pewe seran | START STOP  REC. PUNGH W couT. ReWMo . et | 1 2 5 4 s & 7 @
DECAY DECAY

e fie Eite e fiie e it i -

. MARC START Ho  SPEb CLCK TRAMS SWPTEEMTSMC | 3 08 1 13 13 14 15 1a
[y 00k

o meoucawese—

e wmowccomOL

T e
B e e e s Sihe 4l BB

PARTIALPARTIAL 25 26 27 28 29 30 CHAIN INSERT DELETE SMT  SKT BOUNCE JUSTIFY SEQ t718 19 = 21 22 23 24
NAME

OFF =12 OM:15-24 BLINK 25-28 L OVERALL— L—SCALE ADJUST—I | S——
1-4-1 1u OF || e——e o sTorace TIMBRE CONTROL
ELEC BASSI BEAE N N X NN S AE E > T N N

QOOCeOCOOO

DEPTH DECAY

8 WAVE RATE DEPTH PAN PARTIAL ON/DFF MODE RATE
CHORUS
(R | —) L__PORTAMENTO1
CONTROL — 5L-TIME EFFECTS E—
—YBD ENVLPS EXPRESSION INPUT:

LEFT REPEAT AR VEL. PRESSURE 1 PED. ZMOD WHEEI

KEYERD. BREATH
GN/OFF DN AOFF CN. CONTROL
S 2 B B B 5 - e
LOW  HIGH CHANWEL FILTER CUT/  FC  DECAVHARMOMIC | | INFQ | SEWSERESPONSE MIDI PERFORM REC. OVERWRT.CLEAR
SELECT BODST ADJUST ABUST
LDVME ENVLFS L MULTIFCHARNEL 0UT—— LYELOCITY— L RTEMDDES—
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Sampling

Sampling is the process of digitally recording sound waves into poly RAM. A sound file
results from a sampled recording.

Recalling a Sound File

6

The Librarian can recall sound files from anywhere on the system—poly RAM, floppy
disks, hard disks, optical disks and the Direct-to-Disk. To recall a sound using the
Librarian—

1.

‘L

Sampling

Select TransferMation from the Window menu. This starts the TransferMation
application.

Windowr
Autoconform

TransferMation™
'K Panel

Select the Librarian from the TransferMation Display menu.

| Dispiay

MIDInetd
Autoconform
TransferMation™
MNED StartUp

Transport

Librarian

Patch Bay
Editliew

Press the Index button in the Librarian and select “W0.”

index

E—huttun

& Direct to Disk
2 Poly RAM

Sound Idpac-1

This displays the names of all catalogs and sound files in the system hard drive (WO,
also called Winchester 0).

If this is the first time that WO has been recalled, an updating dialog appears.
After a few seconds, you can continue.
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4. Click the sound file name on the right that you want to select. This becomes the
current sound file in poly RAM.

index name of
button  current wolume

list of catalogs and Tist of sound file names

subcatalogs on Wi

You can also recall a sound file using the RTP—
1. Go to the Main Menu and select the Sound File Directory (B page).

2. The storage devices in your system are listed at the top after “DEVICES.” Click WO,
if it is not already selected.

SOUND FTCE DIRECTORY [¥] [¥] Clear M 3
DEUICES: [1] ALl Winchesters SORT: [A] By Files Only SHOW: [0 Caption

select - [Z] Poly Memary [ By Cats/Files [E] Length in SECONDS

device | We: [F] Fa: [C] By Cats Only [F] Length in MEGABYTES

to view [G] Length in SECTORS

[A] Audition
Contents O W10 [MIPR]T
HBHSS o
. BKBASST  JRZECT JRZZFT POPBASSS PZBSAF1  PZESEBF2  PEZBSOFZ2  PEBSEFS %
PZESF2 PZESE3 STEINC#1  STEIMPOP

select

sound file

3. Torecall a sound file, click its name in the list.

Recording a Sound File

You can record any signal that is connected to the STM input(s) in your system. Use
STM 1A for mono recording and 1A and 1B for stereo recording. Sound is recorded
through the ADC directly into poly RAM, where it becomes a sound file.

To record a sound file—

1. Select the Sound File Editor (L page) from the Main Menu.

2. At the bottom of the page is a list of menus and commands. You will use these
frequently. Click Store/Recall to display the commands for that menu.

menus commands
| |
[ I
A) Display 0) Save H) Collect L) P) 1
B) Modify E) Unsave 1) Record M) 1)) u)
C) SV | F) Rename J) Mox Time N) R) [1)]
¥) Modify 11 6) Recall K) 0) 5) W)

Sampling 7
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3. Click the Record command. Five editable record parameters appear in a dialog.
(Time available merely tells you about how much time in poly RAM is available for

recording.)

Time available is 66.8 seconds.

Mode: STH Mono  Rate: 598.8 kHz Gain: 1.8 times
Trigger: Off Threshold: ©.015 volts

To enter information into the dialog—

4 Ifitis not set already, click the entry after Mode to toggle it to STM Mono or Stereo.

5. Click the Trigger entry to toggle it to Off.

6. Type asample rate after Rate; 50 kHz is the default.

7. Press Return to start recording.

8. Press Stop to stop recording.
A sound file with the default name NEWF1000 is created. (The sound is active on A3
of the keyboard at its original pitch.)

ﬂ If you have selected a command but find you want to stop without completing

the command, press the Enter key.

Displaying a Sound File

When a sound file is recorded or recalled to the Sound File Editor, it appears as a
waveform in the sound file window. Information about the sound file appears above the

waveform.
sound file Current Filename:  BKBASSI Extracted data
information Fate: 3z2.8 kHz Length: 2.883 625 Secs Left: -@.872 valts
Crossfade: =1 ms Cursor: 9. 888 8998 Secsc Fight: ©&.888 volts
labhe]l —®= ORIGIN

L

sound file 2

window f

t

[T BTO3 TIOEd TIOI6 ™z 7161
| ]
T
length in seconds of the

sound file window cursor

waveform of
sound file

Below the sound file window is another bar used for zooming in and out of the sound file
window. The zoom window represents the entire length of the sound file. The portion of
the file currently being displayed is shaded. View more or less of the file by dragging
either end of the shaded portion, or drag the entire shaded portion to display a different
part of the sound file.

total length of sound file

[ 1
5888 Ux a. 85?59909 |.\\\\\\\\\.\\\|

Fesolution: 2.0 @.5 1.8 1.5 Z.@ 2.5 2.883

portion displayed in
sound file window

There are other ways to view the sound file by selecting from the Display menu.

8 Sampling
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(YD isplay D) Show  H) Unlabel L) Left P) Caption T) Dot Mode
B) Modify E) Zoom 1) Center M) Symbols Q) Mark Off U) Zero -—-
C) Store/Recall | F) Search J) Mark Stort N) Print R) Lock U)
%) Modify II G) Label K) Mark End 0) Help 5) Unlock W)

For example—

e Select the Dot Mode command to show one dot for each sample in fine horizontal
resolution. Select again to turn off.

= Select the Zero--- command to display a horizontal line representing an amplitude of
zero volts. Select again to turn off.

e Select the Caption command to add descriptive text.

= Select the Zoom command to look at a smaller or larger area of the sound file. Use
the arrow keys to zoom in and out.

Playing a Sound File

The sound file you recorded is active on the keyboard and sounds at its original pitch

when you press A3. Scrub (play) the sound file by dragging the cursor back and forth in
the sound file window.

You can also change the portion of the sound file that plays—

1. Select the Display menu.

i) isplayl D) Show  H) Unlabel L) Left P) Coption T) Dot Hode
B) Modify E) Zoom 1) Center n Symbols 0) Maork OFf U) Zero ——
C) StorefRecall | F) Search J) Mark Stort N) Print R) Lock U)
¥) Modify II G) Label K) Mark End  0) Help 5) Unlock W)

2. Scrub in the sound file window to the point where you want playback to begin.

3. Click the Mark Start command. A # above the sound file window indicates the
Mark Start.

4. Scrub in the sound file window to the point where you want playback to stop.

5. Click the Mark End command. A $ above the sound file window indicates the Mark
End.

Now, when you play A3 on the keyboard, you will hear only the audio between the
Mark Start and Mark End labels.

sound file playback

—
ORIGIN H b
L
= n Y i, i it " i "
f RN Ir\_,w_,.,-" ||| Sl N e I|I ‘k“,.-,fw R 'II“--\. ...... 4| I|| Yl P‘\.\
[=R=T=Tz] G ad3 ] ] arly d1215
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Editing a Sound File

10

A sound file can be edited in a variety of ways. The edit commands appear in the

Modify menu.
Al Display 0) Reverse H) Delete L) Crossfaode P) Uolume T) Hix
B) E) Cut n Exchange M) Copy 0) Hormalize U) Undo
C) Store/Recall | F) Paste J) Combine N) Fill R) Modulate U) Invert
%] Modify I1 G) Extract K) Ext Mono 0] Loop 5) Rew Loop W) OC Trim

For example, the Cut command is used to remove audio from the sound file—

1.

Sampling

Select the Cut command from the Modify menu.

Enter begin, end, crossfode times or use the mouse to cut
=>

Scrub in the sound file window to the beginning of the edit. When you let go of the
trackball button, the time is entered into the dialog as the beginning of the edit.

Scrub in the sound file window to the end of the edit. When you let go of the
trackball button, the time is entered into the dialog as the end of the edit.

If you press Return now and do not type a crossfade time, .005 seconds is entered
automatically. You can type a different time, if desired.

Enter begin, end, crossfade times or use the mouse to cut
=> 9.839 562.0.85% 187.0.805 008 [RETURN confirms]

Press Return.

A new sound file with the default file name NEWF[number] is created. The cut
portion has been removed.

The cut portion remains in an edit buffer that acts as a clipboard. To splice the
contents of the edit buffer into the sound file—

Scrub in the sound file to the place where you want to paste the edit buffer.

Select the Paste command from the Modify menu.

Enter name of file and number of copies to paste
=>

Press Return twice to paste the contents of the edit buffer.
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Saving a Sound File

To retain the changes you have made to a sound file, you must save it. Until you save a
sound file, any changes only take place in poly RAM. If you power down the system, all
your changes will be lost.

To save a sound file—

1.

Select the Store/Recall menu.

A) Display D) Save H) Collect L) P) T)
B) Modify E) Unsave 1) Record M) Q) u)
] F) Rename J) Mox Time H) R) u)
%) Modify II 6) Recall K) 0) 5) W)

Select the Save command.

Enter name of file to save

=>

If you want to save the file under its current name, press Return.
OR

If you want to save the file under a different name, type that name.

Press Return.

Every sound file has a name. Any time you record or modify a sound file in poly RAM, a
new file is created automatically with the file name NEWF[number]. You can assign a
different file name by saving (as described above) or renaming.

To rename a sound file in poly RAM—

1.
2.

Select the Store/Recall menu.

Select the Rename command.

Assign new filenome to current sound file
=>

Type the new name of the sound file.

Press Return to save the sound file under its new name. It does not appear under its
old name anymore.

Sampling 11
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Timbre Design

A timbre is another name for musical sound. Most Synclavier timbres were created by
recording samples from live instruments and saving them as sound files on the system
hard disk. A Synclavier timbre has up to four layers of sound. Each layer is a separate
set of sound files, called a partial timbre. The Synclavier Company has provided you
with a number of timbres. You can also create your own.

Timbre
partial partial partial partial

timbre 1 timbre 2 timbre 3 timbre 4

A B B

sound files patched to keyboard

Using the Timbre Directory to Recall a Timbre

12

To recall a timbre—
1. Select the Timbre Directory (A page) from the Main Menu.

2. The Timbre Directory presents a list of timbres that you can recall. Click any timbre
name to recall that timbre.

— BANK 1 —— — BAMK 2 —— —— BANK 3 —— —— BANK ¥ ——
HORKSPACE BEALL/SHOT .46 TUMBA 1% ELEC BASS1 .18
LIUE DRUMS .37 CROSS STICKE &2 COMGA .36 POPBASSI B
FI FTRIM ETT 26 TOTOSAN AR MHITNTN 34 RASS LIAPOP ey

3. Watch the Synclavier keyboard display window. As each sound file that makes up
the timbre is loaded into poly RAM, its name appears in the window.

LORDING SOUND
FILE "BKBASS1"

When the window displays the name of the timbre, all of the sound files associated
with the timbre have been loaded, and the timbre is active on the keyboard.

1-4-1 1U 0F
ELEC BRASSI1 .18

Timbre Design
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Using the Synclavier Keyboard to Recall a Timbre

The Timbre Directory is organized on a grid. The location of a timbre is identified by
going across to a numbered BANK and down to a numbered ENTRY.

— BAMK @ —— —— BAMK 3 —— —— BAMK 4 ——

1. BEALLASHOT .96 TUMEBA .14 ELEC BASS1  .1§

E 2. LIUE DRUMS .37 CAROSS 5TICK .82 COWGA .36 POPBASS B
W 3. ELECTRIC KIT .26 TOTOSAN g QUINTO 3% BASS WAPOP .26
T 4. ELEC KIT #2 .27 NANBO BELLS .22 TINBALES .42 STEIMBERGER .37
R 5. DORUM MACHIME .31 BOWGO BELLS .15 SHEKERE AT SBRSS UAFOP 4
Y 6. BORUM/SMARE .1 WOOD BLOCKS .1 GAWZA A7 PHASED EBRSS .15
7. RIDE CYMBALT .47 PERCUSSION .33 TRIAWGLE 42 PHASED SBASS .37

g. RIDE CYMBALZ .45 TRBLA .66 TAMBOURIME .49 ACOUSTIC BS Z2.67

Use keyboard panel 4 to recall a timbre using BANK and ENTRY numbers.

T IMERE S SEQUENCE STOR AGE m—
— TIMERE— | —SEQUENCE—,

LIERARY BAME.  ENTRY LIERARY SEQ. SFLIT PROTECT “WRITE

z 5

1. Find atimbre in the Timbre Directory that you want to recall. Note its BANK and
ENTRY numbers.

Press the BANK button in panel 4.
Press the numbered button below it corresponding to the BANK number.
Press the ENTRY button.

Press the numbered button below it corresponding to the ENTRY number.

o g~ WD

When the display window shows the name of the timbre, all of the sound files
associated with the timbre have been loaded. The timbre is active on the keyboard.

Each time you recall a new timbre, the previous timbre is replaced on the keyboard.

Listening to the Partial Timbres

You use the PARTIAL TIMBRE SELECT buttons on panel 1 to solo partial timbres. For
this example, you might want to recall one of the timbres from BANK 7, many of which
have more than one partial timbre.

TIMERE PARAMETERS e ———

PARTIAL TIMERE ———+0LUME ENYELOFE—————————

SELE

1 z | DELay aTTack MITIAL FINAL - prae sysTaAm
DECAY DECAY

L HARMOMIC ENVELOPE————

Timbre Design 13
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To solo a partial timbre—

Recall a timbre to make it active on the keyboard.
Press the lighted PARTIAL TIMBRE SELECT 1 on panel 1.

When you press a lighted partial timbre button, it begins to blink. Blinking means
the partial timbre is soloed.

Play some notes on the keyboard.

You hear only the partial timbre that is soloed.

Press PARTIAL TIMBRE SELECT 2.

When you play on the keyboard, only partial timbre 2 plays.
Press PARTIAL TIMBRE SELECT 2 again.

The button stops blinking and the entire timbre is active on the keyboard. Whenever
no partial timbre button is blinking, the entire timbre plays.

Repeat with the other partial timbres. You can also press more than one partial
timbre button at a time to solo more than one partial timbre.

Creating a Patch List

14

‘L

A patch list is a group of sound files on a single partial timbre. Each sound file in the
patch is assigned to a region of the keyboard for playback.

A list of the sound files and their keyboard assignments for the current timbre appears in
the Patch Display (I page). You can look at the patch list for each of the four partial
timbres by pressing the Spacebar, or by pressing a partial timbre button on the Synclavier
keyboard.

To place a sound file in a patch list—

1.

2.

Before you create a new patch list, you should first erase any track timbres and recall
an empty timbre. To erase any existing track timbres, press ERASE twice on panel 2.
To recall an empty timbre, hold down SKT on panel 2 and press TRACK SELECT 1
on panel 3.

Go to the Main Menu and select the Patch Display.

The trackball does not work in the Patch Display. Use the arrow keys on the
Macintosh keyboard to move around the display.

3.

Press the Spacebar to cycle through the four partial timbres. Now select the first
partial timbre.

Timbre Design
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4. Press Return to start the patch list.

Keyboord Timbre: 1-86-1
Current Cotalog: We:

Partial # 1: Memory Left: 5.9 Megobytes
File Stort End VUolume Tronspose Tuning Total Length Loop Length
1. ] ce C? 100.9 6.00 ©.000 000 0.000 000

5. Now you are ready to add the first sound file to your patch list. Press Control-C to
go to the Sound File Directory.

6. Select a sound file to place in the patch list, and press Return.
The sound file is automatically added to the patch list.

7. Toadd a second entry to the patch list, press the down arrow key. The cursor moves
to the next line in the patch list and another entry is created.

8. If you know the name of the sound file you want to add, you can type itin. Or, you
can add a sound file from the Sound File Directory, as you did in Step 5

To delete a sound file from the list, place the cursor on that sound file entry and press
Delete on the Macintosh keyboard. To add a sound file entry within the list, press and
hold the Shift key while pressing the hypen key.

Now that a sound file is in the patch list, you can assign it to a region of the Synclavier
keyboard. After each sound file name are columns labeled Start and End. This is for
entering a pitch letter and an octave number for the region. The lowest key on the
keyboard is AO. The lowest C is C1. The highest key is C7. By default, each new sound
file in the patch list is assigned to the entire keyboard.

To assign a sound file to a portion of the keyboard—
1. Arrow to the Start column for the first sound file. Type a pitch letter and octave

number for the lowest key in the range.

2. Arrow to the End column for the first sound file. Type a pitch letter and octave
number for the highest key in the range.

3. Repeat for each sound file in the patch list.

Regardless of the pitch at which a sound file was recorded, its original pitch normally
sounds only when you play A3. The original sound change pitch as you play higher or
lower on the keyboard. You can, however, assign the original pitch to any key on the
keyboard.

1. Arrow to the Transpose column of the sound file you want to move.

2. Decide which key you want the original pitch of the sound file to play on and type
that key.

Timbre Design 15
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Modifying a Partial Timbre

Each partial timbre can be modified to distinguish it from another partial timbre. One of
the parameters that can be adjusted is the volume envelope. This is the shape of the
volume of the sound.

Jolurme

Delay Attack Initial Sustain Final Decay
Decay

peak |level

sustain level

Duration of Key Depression —

The VOLUME ENVELOPE buttons are on panel 1, to the right of the partial timbre
buttons. These six buttons are active for whichever partial timbre is selected.

FARTIAL TIMERE

TIMERE P AR AMETERS e _ _———

——————OLUME ENYELOPE————————

L
DECAY DECAY

FEAK SUSTAIN

L HARMOMIC EMVELOFE — 1

To change the volume envelope of a partial timbre—

1. Light the partial timbre button of any partial timbre you want to adjust. You can
light more than one at a time.

2. Press the volume envelope ATTACK button.
The display window on the Synclavier keyboard or the VK panel shows the attack
value in milliseconds. Use the control knob next to the display window to change the
attack value of the selected partial timbre(s).

1236 HILLISEC

All of the sound files on the selected partial timbre(s) are adjusted to the new attack
value. You can hear the difference by playing on the keyboard.

3. When you are done adjusting the attack, press any of the other volume envelope
buttons and adjust them.

J' Many buttons turn off automatically when you press another button. You can

force the button to turn off by pressing the CLEAR button on the button panel 5.

16 Timbre Design



Tutorial for the Synclavier|

Adding Real-Time Effects

A real-time effect (RTE) is a performance controller that changes the characteristic sound
of atimbre. There are eight controllers on the bottom of button panel 5 under
EXPRESSION INPUTS.

I F:E AL-TIMME EFFECTS

—————————  ERPRESSION INPUTS —————

VEL. PRESSURE PEDR. 1 PED. ZMOD WHEEL RIE. KEYEBRD. BREATH

cV. CONTROL

IMFO | SENSE RESPOMNSE MID| PERFORM REC. OVERWRT. CLEAR

L MELOCITY — L RTE MODE! |

Each controller can be patched to one or more partial timbres and one or more timbre
parameters, such as track volume. For example, if you patch the mod wheel to track
volume, moving the mod wheel while playing increases or decreases the volume.

1.

To clear any current routing, press and hold CLEAR button on panel 5 while pressing
the MOD WHEEL button.

Press and hold MOD WHEEL while you press TRACK VOLUME on panel 2.
The mod wheel now controls the overall volume of the timbre.

Move the mod wheel while you play A3 on the keyboard.

You can hear the range of volume settings from zero to full volume.

Release A3 when you reach the volume that you like.

Play A3 again to hear the volume you selected.

Solo a partial timbre and try steps 1-4 again. The mod wheel will control the volume
of only the soloed partial timbre.

You can assign any of the RTEs to any button that has a white dot next to it. These are
examples of typical routings—

Mod Wheel to Vibrato Rate and/or Depth
Velocity to Partial Volume

Velocity to Partial Tuning

Timbre Design 17
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Saving a Timbre

18

‘L

When you store a timbre in a timbre file, you save the names of the sound files on each
partial timbre, any modifications that have been made and the timbre name. The sound
files themselves remain on disk. When you recall the timbre, its definition is recalled
from the timbre file and then the appropriate sound files and effects are loaded.

In this tutorial, you are going to store your timbre in Bank 1, Entry 1 of your current
timbre file. This is the first space on the Timbre Directory display. Usually this space is
empty. If itis not, and you do not want to replace the timbre that is currently located
there, store to a different BANK and ENTRY in the timbre file. Storing destroys the previous
timbre that was in this location. Be careful.

Before you store a timbre, you need to give it a name—

m  Select Name Keyboard Timbre from the Main Menu and type the name you want
to give to your new timbre. Press Return to enter the name.

Use the buttons on panel 4 to store your timbre in the current timbre file—

I T [MERE /SEGUENCE STOR 4GE I
— TIMBRE___ | SEQUENCE_,

LIERARY BANE  ENTREY LIBRARY SEQ.  SPLIT PROTECT WRITE

1. Press BANK and then numbered button 1.
2. Press and hold WRITE while you press ENTRY.

You are about to destroy the timbre in BANK 1, ENTRY 1. If you do not want to do
this, release the WRITE button and the procedure will be canceled.

3. Continue to hold WRITE while you press numbered button 1.

Your timbre has been saved to the first bank and entry of the current timbre file.
4. Go to the Timbre Directory.

The name of your new timbre appears in BANK 1, ENTRY 1.
It is essential that you press the buttons in the proper order. If the storage was

not successful, repeat the procedure, making sure to execute the steps in the
correct order.

Timbre Design
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Recalling and Playing Sequences

Several sequences are already stored on your system hard disk. Eight of the prerecorded
sequences are numbered; the remainder have names that help to identify them.

Recalling a Sequence

‘L

To recall a sequence using TransferMation—

1. Activate the TransferMation Librarian.
2. Select Sequences from the Index button.
All sequences on W0 and W1 are listed on the right.

3. Click the name of the sequence that you want to recall.

CATALOG 2

W1

SODATAS

To recall a sequence using the RTP —

1. Select the Sequence Directory from the Main Menu.

Sequences on the current storage device are listed. Numbered sequences appear at
the beginning of the list, followed by sequences that have been named.

<SEQ #1> <SEQ #2> <SEQ #3> <SEQ #4> <SEQ #5> <SEQ #6> <SEQ #7 > <SEQ #8>
12STRING BACH-J0Y BONELOOP COMPARSA NANINGD [ENIUE TABLA  TINTAL

2. Click the name of the sequence that you want to recall.

The sequence is ready to play when the keyboard display window shows the number of
notes left after loading the current sequence.

154,857 LEFT

If you recall another sequence, it replaces the current sequence. Both
sequences, however, still remain stored on the hard disk.

Recalling & Playing Sequences 19
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Playing a Sequence

The buttons on panel 2 of the Synclavier keyboard control the sequencer.

I = TR ACK DIGIT AL
RECORDER CONTROL ———————

START STOP REC. PUMNCH IM COMNT. REWIMD F.F. ERASE

= Press the START button to begin playback. As the sequence plays, the keyboard
display window shows beats and measures.

= Press the START button twice to play the sequence from its first note.
= Press the STOP button to stop the sequencer.
= Press CONT to continue playing the sequence from the point where you stopped it.

= Press F.F. to move the sequence forward. The more times you press the button the
faster the sequence plays.

= Press REWIND to move backwards in the sequence. The more times you press the
button the faster the transport moves.

If none of the track select buttons onpanel 3 are lit, you hear all the tracks during
playback. To solo one or more tracks, press and light the track select buttons.

A MADIR:* 2B o .
TRACK SELECT

Setting a Mark Point

If you want to start playing back or recording at a point other than the beginning of the
sequence, you can set a mark point.

Z2 TRACK DIGITAL
I RECORDER COMTROL———————

START STOP EEC. PUMCH IM COMT. EEWIMD» F.F. ERASE

M&RK START  EMD  SPEED  CLICK T =1 EX NC
LOOF  LOOP R&TE MODE  MODE

20 Recalling & Playing Sequences
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To set a mark point—

1.
2.
3.

Press the MARK button on panel 2.
Turn the control knob to set a starting beat number.

Press START to begin playing from the mark point.

You can also set a mark point while the sequence is playing—

1.
2.
3.

Press START to play the sequence.
Press and hold MARK.

When the sequence reaches the desired mark point, press CONT and release both
buttons.

Press START to begin playing from the new mark point.

Changing the Speed

You can play back a sequence at a different rate without changing its pitch.

I FECORDER CONTROL ————————

Z2 TRACK DIGIT AL

MARK  START  EMD  SPEED CLICK TRAMS SMPTE EXT SYNC
LOOF  LOOP R&TE MODE  MODE

Press the SPEED button on panel 2.
The display window shows 1.000 SPEED.
While the SPEED button remains lit, press START to play back the sequence.

Turn the control knob clockwise to increase the speed and counterclockwise to
decrease the tempo.

When you finish experimenting with the speed, press SPEED again to return the
setting to 1.000.

Press STOP to stop the sequence.
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Recording

In this section you will create a multitrack sequence on the Synclavier.

Preparing to Record

Before recording, you need to erase the notes currently in the sequencer and set the
metronome to a comfortable tempo.

ZZ2 TRACK DIGITAL

START STOP  REC. PUNCH IN CONT. REWIND FF. ERASE

MaRE  START  EMD»  SPEED  CLICK  TRAMS SMPTE EXT SYNC
LOoF  LOOP RATE MODE  MODE

FECORDER COMTROL

To erase notes currently in the sequencer—
m  On panel 2, press the ERASE button twice to erase the sequence.

Erasing does not affect the sequence stored on the system hard disk, it only erases
what is in poly RAM.

To set the metronome—
1. Press the START button and listen to the clicks of the digital metronome.

2. Torecord at a different tempo, press the CLICK RATE button and turn the control
knob until the click rate is where you want it.

3. After you have set a comfortable rate for recording, press STOP.

Recording the First Track

Z2 TRACK DIGIT AL
I RECORDER COMTROL—4—0

START STOP  REC. PUMCH IN COMT. REWIND FF.  ERASE

rMaRE START  END  SPEED  CLICK  TRAMS SMPTE EXT SYMC
LOoF  LOOP RATE MODE  MODE

Select the Timbre Directory from the Main Menu.
Recall a timbre.
Press RECORD on panel 2 to begin recording.

Play some notes on the keyboard.

SAE I A

When you are satisfied with the recording, press STOP.
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If you are not satisfied with the results of your recording, you can always erase the entire
sequence and start again. To erase the sequence—

m  Press the ERASE button twice. All notes on all tracks in the sequence are erased.

Recording the Second Track

Now that you have recorded the first track, you can lay down a second track while
listening to the first.

1. Recall another timbre from the Timbre Directory.
2. Press RECORD on panel 2.
3. Play some notes for track 2.

Look at the TRACK SELECT buttons and notice that the first track is automatically
soloed for recording the first timbre and the second track is automatically soloed for
recording the second timbre. This is because two timbres cannot be recorded on the
same track. If you do not manually solo a track by pressing a TRACK SELECT
button before you record, the system will automatically select a track for you.

4.  When you finish recording, press STOP.

Now that you have recorded more than one track, you may be satisfied with the first
track but dissatisfied with the second track. To retake an individual track—

1. First erase the notes on the track. Press the TRACK SELECT button of the track you
want to erase, and press ERASE twice to erase only the notes on that track.

2. Press RECORD.

3. Play the notes for selected track 2.

4. When you finish recording track 2, press STOP.
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Editing the Sequence

You can edit your sequence in many ways, such as changing a track timbre, adding notes
to a track, punching over notes on the track, bouncing a track or transposing the
sequence.

Adding Notes to a Track

To add notes to a track you have already recorded—

1.

2
3.
4

Recall a timbre from the Timbre Display.

Solo the track on which you want to add notes.

Press RECORD on panel 2.

Play the additional notes against the background of the current notes.
The notes you play are merged with the track.

When you finish recording, press STOP.

In the above example, if there had been a different timbre on the keyboard than the one
on the track you selected, the message “TIMBRES MUST MATCH FOR RECORD” would
have appeared in the keyboard display window. A quick way to make the timbres match
is to—

Press the SKT (Select Keyboard Timbre) button on panel 2.
Press the TRACK SELECT button of the track on which you want to record.

This recalls the track timbre to the keyboard. Now you can continue to record
additional notes to the track as explained above.

Punching Over Notes On a Track

24

Punching into a track replaces any previously recorded notes at that location.

32 TRACK DIGITAL

—————————RECORDER COMTROL

Ma&RK  START  EMD  SPEED  CLICK  TRANS SMMPTE EXT SYNC

LOOF  LOOF RATE MODE  MODE

Solo the track you want to punch into.
Press RECORD.

Let the sequence play to the point where you want to punch in. You will hear all
tracks, but you will only punch into the soloed track.

Press the PUNCH IN button when you are ready to record, and play the new notes.
The previous notes on a track are erased while you record.

Press PUNCH IN a second time when you want to stop recording.

Editing the Sequence
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Changing a Track Timbre

You can assign a new timbre to the notes on a track without re-recording the track.

ST SKT B

OVERALLOCTAVE PITCH  KEY  SCALE TRACK TRACK TRACK

TUMING REATIO CLASE  OMLY RESET WOLUME FPAM ROUTING
L OVERALL— L SCALE ADJUST—3 L M 1

ISAE R A

Recall the new timbre from the Timbre Directory.

Press the SMT (Select Memory Timbre) button on panel 2.

Press the TRACK SELECT button of the track timbre you want to replace.

Press the SKT (Select Keyboard Timbre) button on panel 2.

Play back the sequence to hear the new timbre.

Transposing a Track

4

You can transpose a track by an interval equivalent to the interval between middle C and
any other key you press.

To clearly hear the effect of transposing a track, it is best to transpose a track
with pitched material on it. A drum track or dialog does not work as well.

N o o M w Db

Z2 TRACK DIGITAL

——————FRECORDER CONTROL

FF. ERASE

MAREK  START  EMD  SPEED  CLICK  TRANS SHPTE EXT SYMHC
LoaF  LOOP RATE MODE  MODE

Solo the track you want to transpose.

Press STOP.

Press the TRANS (transpose) button on panel 2.

Press START to hear the sequence while transposing.

Press TRANS again to leave the transpose mode.

Press START again to hear the transposition of the track.

Press a key, other than middle C, on the Synclavier keyboard.
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Ending the Tutorial

All Synclavier recording and editing is done in temporary memory. Before turning off
the system, you must store your sequence on the hard disk, otherwise the notes will be
lost.

Saving Your Recording

26

When you store a sequence, you save such things as the names of the track timbres and
their parameters, the click rate and speed settings, the current mark point, and much
more. The sound files associated with the timbres remain on disk. When you recall the
sequence, the timbres and sound files are recalled automatically.

In this tutorial, you are going to store your sequence in one of the eight numbered
sequence files. You are going to use number 8, which is usually a duplicate of the
sequence Naningo. However, if there is something in sequence file 8 that you do not
want to replace, store your sequence to a different numbered sequence file. Storing
destroys the previous sequence that was in that location. Be careful.

Use the buttons on panel 4 to store your sequence to a numbered sequence file—

T |ERESSEQUENCE STOR AGE —
———TIMERE———  —SEQUENCE—

LIBEARY BE&ME  ENTEY LIBRARY SEQ.  SPLIT PROTECT WRITE

=]

1. Press and hold the WRITE button on panel 4.
2. While holding WRITE, press the SEQ button.

this, release the WRITE and SEQ buttons and the procedure will be canceled.

f You are about to destroy the sequence in <SEQ #8>. If you do not want to do

3. Continue to hold the WRITE while you press button 8.

Your sequence is how stored in <SEQ #8>, which can be recalled later from the
Librarian or the Sequence Directory.

It is essential that you press the buttons in the proper order. If the storage was
not successful, repeat the procedure, making sure to execute the steps in the
correct order.

‘L
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Turning Off the System

When the Synclavier powers down, all notes in the sequencer and all sound files in poly
RAM are erased. Sound files, timbres and sequences saved on the hard disk remain
intact.

In TransferMation, select Quit from the File menu.
Return to the Main Menu and select Quit from the pulldown File menu.

To power down your Macintosh, select Shut Down from the Special menu.

Lift the superfloppy drive lever and remove the Bootload disk.

a M w0 PR

Power down the Synclavier and any peripherals.
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What Is Sampling?

Sampling is a process of digitally recording sound waves.

Analog and Digital Waves

Vibrating sources, such as human vocal cords or an acoustic musical instrument, create
waveforms. The vibrations push and pull the air molecules adjacent to the source,
creating a sound wave that travels through the air. When the sound wave strikes another
object, such as the human ear or a microphone, it causes that object to vibrate.

In order for a computer to record and manipulate sounds, it must have a way to
represent sound data numerically. The process of converting a waveform into a digital
representation of that waveform is called sampling. Sampling involves repeatedly
measuring the amplitude of a waveform and saving those data points. Each data point is
called a sample. The Synclavier can distinguish 65,536 different levels of amplitude,
each expressed as a 16-bit number.

During the process of converting an analog wave into a numeric representation, the
amplitude of the wave is measured, or sampled, many times each second. The sampling
rate is the number of times the amplitude of a sound is measured in one second. The
Synclavier can sample at rates between 1000 and 100,000 times per second (from 1 to 100
kHz). The higher the sample rate, the more accurate the representation of the sound, and
more memory that’s required.

This conversion process is accomplished by using an analog-to-digital converter (ADC).
The ADC generates a list of numbers called a sound file. This list is stored in the
Synclavier’s polyphonic sampling memory (poly RAM). It can also be stored on a disk.
When you press a key to trigger a sound, the information in the sound file is sent to a
digital-to-analog converter (DAC), which reconstructs the original analog waveform from
the digital samples. The final output of a sampled sound comes from the POLYPHONIC
SAMPLING OUT jacks on the control unit, which can be connected to your sound
system. The left and right outputs are a composite of sounds produced by the keyboard,
guitar and sequencer. They are available through both 174" phone jacks and XLR jacks.

Stereo and Mono Sound Files

Sound files can contain information for one or two channels. When a sound file contains
information for only one channel, it is called a mono sound file. When it contains
information for both channels, it is called a stereo sound file. The two channels of a
stereo sound file are generally designated as left and right.
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Recalling Sound Files

Sound files can be stored on the system hard disks, floppy disks and optical disks. When
you recall a sound file, it resides temporarily in poly RAM and is active A3 of the
Synclavier keyboard. This is the current sound file.

Recalling Sound Files

&

Each sound file is identified by a sound file name that is a combination of up to eight
letters, numbers and symbol characters. There are several windows from which you can
view a list of stored sound files and recall one to poly RAM. TransferMation and the
Sound File Directory are described here.

If two sound files with the same name are stored in different subcatalogs, the
system will load the first one it finds. Try to use unique file names, by combining
different of letters and numbers.

The TransferMation Librarian can recall sound files located anywhere on your system—
optical disks, floppy disks or hard disks.

1. Select a volume from the Librarian Index button.

index

E—huttun

2 Direct to Disk
2 Poly RAM

“nund Ideac-1

This displays the names of all catalogs or categories on the left and the sound file
names on the right.

index marne of
buttan current volume

list of catalogs and Tist of sound file names

subcatalogs on Wi

2. Double-click the sound file name that you want to recall. This becomes the current
sound file in poly RAM.

The Librarian can also recall a DTD cue to poly RAM where it can be saved as a sound
file. Select the cue and then select Transfer to Poly from the Librarian Local menu. (For
more information on using the Librarian, see the chapter “Recording and Editing with
the PostPro” in Manual I.)
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To recall sound files from the Sound File Directory—

1. The storage devices in your system are listed at the top under “DEVICES.” Select the
storage device on which the sound file is located by clicking the name or typing its
number into the box. This displays the sound files on that device.

[SOORE FTCE TTFECTORY | [¥] Clear LN =
DEVICES: W ALl Winchesters GORT: [ By Files Only SHOW: [B] Caption
[Z] Poly Memory B By Cats/Files [E] Length in SECONDS
[ ue: [F] Fa: [C] By Cats Only [F] Length in MEGABYTES
[5] Length in SECTORS
[F] Audition
Contents of ALl Hinchesters HFIR]T
L'JEFISS 2
l BKBASS1  JRZ2CH JAZZF1 POPBASSI PZBSAF1  P2BSBFZ  PZBSOFZ2  PE2BSEF3 %
PZBSF2 F2B563 STEIMCH1 STEIMPOP

2. Torecall a sound file, click its name in the list.

g Click the M button near the top right of the screen, or type m, to toggle the

- display to full view of sound files. Even when the commands at the top are
hidden, they still can be activated by typing their letters.

J' You can use the Sound File Editor’s Recall command to recall a sound file from

the Sound File Directory. Use Control-C to go to the Sound File Directory
automatically from the Sound File Editor.

For more information on using the Sound File Directory and the Sound File Editor, see
the chapter “Real-Time Program” in Manual I11.
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The Sound File Editor

When you recall a sound file to poly RAM, it is represented graphically on the Sound File
Editor (L page). This display is used to view, record and edit sound files.

Sound File Information

The top of the display contains information about the current sound file.

Currenti Fllanome:

Anote: 54 ./
Croscsfada:

command

Current Filename

Rate

Crossfade

Length
Cursor
Left

Right

| SANPLE-TO-NEMORY SOUMD EDITOR |

JAZECT Extrocied daio
Length: 3.77 684 Secs Left: —4.823 volis
mE: Curcor: @, @38 d8d Sococ Right: @.@38 uwolic
function

The name of the sound file active on the keyboard or the first
sound file on the partial timbre patch list. The sound file caption is
shown next to the filename.

The sampling rate used when the sound file was created.

The current default crossfade setting. This is used for crossfades
between edits in the sound file.

The duration of the sound file in seconds.
The current sound file cursor position in seconds.

The amplitude of the sound file’s left channel at the current cursor
position.

The amplitude of the sound file’s right channel at the current
cursor position.

Menus and Commands

Each of the four menus located at the bottom of the screen displays a list of commands.
Click the menu name to display the commands.

To activate a command—

1. Select a menu by typing the letter next to it, or by clicking the menu name. For
example, to select the Display menu, type A or click Display.

2. Select a command from the resulting list in the same way.

3. Once you select a command, the command list is replaced by a dialog. Follow the
instructions and enter any information requested.

4. To complete the command, press Return. To abort a command, press Enter or click
the close box in the upper right corner.
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Menus Commands
A) Display D) Show H) Unlabel L) Left P) Caption T) Dot Mode
E) Zoom 1) Center M) Symbols Q) Mark Off U) Zero---
F) Search J) Mark Start N) Print R) Lock V)
G) Label K) Mark End O) Help S) Unlock W)
B) Modify D) Reverse H) Delete L) Crossfade P) Volume T) Mix
E) Cut 1) Exchange M) Copy Q) Normalize  U) Undo
F) Paste J) Combine N) Fill R) Modulate V) Invert
G) Extract K) Ext Mono O) Loop S) Rev Loop W) DC Trim
C) D) Save H) Collect L) P) T)
Store/Recall E) Unsave 1) Record M) Q) U)
F) Rename J) Max Time N) R) V)
G) Recall K) 0) S) W)
X) Modify |1 D) TSM

Sound File Window

‘L
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When you recall a sound file to poly RAM, it is represented in the sound file window as a
waveform and is active on the keyboard. The top window shows the left channel and the

bottom window shows the right channel.

labe]l —WORIGIN

sound file
window

-~ somo

=

A PANAPAPP-

[=I=1]

[-M=kE]

[-M=1=T:

[2M2=] =)

waveform of
sound file

length in seconds of the

sound file window

CUursor

If there is no sound file in poly RAM, the message “Sound file not available”
appears in the sound file window.

Scrub (play) the sound file by dragging the sound file cursor (the vertical bar in the

window) back and forth across the sound file window.

The sound file cursor can also be moved using the arrow keys. Press the left or right
arrow key to move slowly. Press the up or down arrow key to move 1/4 of the window.
You can also play notes on the keyboard to hear the sound file; press A3 to hear the
original pitch or press other keys to hear pitch-shifted versions.

Below the sound file windows is the zoom window. The zoom window represents the

entire length of the current sound file. The portion of the file currently being displayed in

the sound file window is shaded. You can view more or less of the file at a time by
dragging either end of the shaded portion. Drag the entire shaded box to a different

location in the zoom window to view a different part of the sound file.
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total length of sound file
[ I 1
5.888 Ux 8. 857 secs KSSSSSSSSSS&
s ; :

Fiesolution:

a.a .5 1.8 1.5 Z2.a 2.5 2.883

portion displayed in
sound file window

When a sound file is recorded, the horizontal scale of the sound file window is set so that
the entire sound file (or a maximum of 140 seconds) is displayed, and the vertical scale is
5 volts (lower values magnify small amplitude signals). The current horizontal and
vertical scale settings are shown to the left of the zoom window.
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Recording Sound Files

When you sample a sound using the Sound File Editor, you record it into poly RAM,
after which it can be saved as a sound file.

The Sampling Process

You can record mono or stereo signals entering through the ADC inputs in your system
at sampling rates up to 100 kHz. This sound is recorded directly into poly RAM where it
becomes a sound file that can be edited and/or stored on the hard disk, optical disk or
floppy disk.

If you have a Synclavier keyboard, the sampled sound becomes the first partial timbre of
the keyboard timbre, replacing the previous timbre. As a partial timbre, the sound file
can be modified, assigned to a keyboard patch and/or recorded into a sequence.

The following is an overview of the sampling process. Each step is described in more
detail later—

Select the Record command from the Store/Recall menu of the Sound File Editor.
Select the appropriate ADC module and mode.

Set the trigger mode.

If the trigger is “On,” set a trigger threshold level.

Select the sampling rate.

Set the record level.

N o o &~ w D

Start and stop recording by pressing Return on the Macintosh keyboard.

Preparing To Record

Select the Record command from the Store/Recall menu to set up the recording
parameters. Enter the following information into the resulting dialog—

Time availoble is 68.8 seconds.
Mode: S5TH Mono  Rote: 98.8 kHz Gain: 1.9 times
Trigger: On Threshold: 9.815 volts

m  Time available—make sure you have enough time available in poly RAM for the
sound(s) you are about to record. (See “Poly RAM Management” later in this
chapter.)

m  Mode —the selected ADC and mono/stereo status. When you enter the RTP, the
ADC module is set for mono sampling. If you want to record in stereo, or if you have
the Sample-to-Disk (D66) sampling module, press the Spacebar until the appropriate
mode selection appears.
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Recording

&

m Rate—the number of samples taken each second. Sound files with higher sampling
rates have increased fidelity, but they use more memory and require additional disk
space. The default sampling rate is 50 kHz..

m  Gain—the upper sound file window shows a horizontal peak level meter and the
message “Performing level check...” The last segment of the meter indicates
clipping. If you are recording a stereo sound file, a separate meter is active in each
sound file window. The meter in the keyboard display window indicates the level of
the higher of the two input signals.

Set the Gain for optimum level by entering a whole number between -3 and +28 dB.
Negative gain settings provide up to 3 dB of attenuation. Or, adjust your console or
preamp levels for optimum performance to eliminate any causes of distortion.

m  Trigger and Threshold—set the trigger status to “Off” if you want to start
recording as soon as you press Return. Set the trigger status to “On” if you want to
start recording when the level of the incoming signal reaches the specified threshold
setting; any recorded signal at the end of the sound file that is below the threshold
level will be trimmed from the sound file.

Once you have set the recording parameters and the record level as described above, use
the Return key to start and stop recording into poly RAM.

Once recording has stopped, the sampled sound is stored as a sound file named
NEWF[number] in the current catalog and is active on the keyboard at its original pitch
when you press A3. Distortion occurs as you play notes other than A3.

You can view a waveform of the sound file in the sound file window. ORIGIN marks
the start of the sound file. END marks the end of the sound file. (The END mark may

not be visible if the resolution setting is high.)

If you have a multiple poly bin system, you can only record into poly bin 1.

Synchronized Sampling

&

Synchronized sampling is often used for recording vocals, Foley effects or dialog
replacement synced to the current sequence. The resulting sound file is recorded to a
track and plays back at the appropriate time in the sequence.

Before attempting synchronized sampling, you should understand how to record
a sequence. See Chapter 5 and 6.
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To perform synchronized recording of a sound file—

1. Make sure you have completed the instructions in “Preparing to Record” above. Set
the trigger status to “On.”

2. Press START on panel 2 to locate a cue point in the sequence.

3. Press RECORD to start recording. The sequence begins to play from the mark point
or current location. The sound is recorded onto the first available sequence track and
into poly RAM.

Make sure that at the point in the sequence when synchronization is desired the
incoming signal is at the specified threshold.

4, Press RECORD or STOP.

If you press RECORD , the sequence continues to play, but sampling stops. If you
press STOP, the sequence stops playing.

The sound file now plays as an event in the sequence.

5. Make sure that you regularly save the sound file and sequence to disk.

If you do not want to hear previous takes while you are recording new ones, then before
recording, first solo any tracks that you want to hear and then select the track on which
you want to record.

To quickly unselect the track that was previously blinking, and select the track on
which the next sound is to be recorded, press both buttons simultaneously.

The sequence can be playing while you are recording and selecting tracks. For
multiple takes, you can place an overall loop on the sequence.

Sampling from an External ADC

If you have a DTD system, you can record directly into poly RAM using as your source
any signal plugged into the DTD inputs.

To do this, remove the short ribbon cable connecting the ADC to the DTD control unit.
Connect the black ribbon cable, supplied with your DTD, from the connector labeled
SAMPLE-TO-MEMORY OUT on the DTD to the connector labeled SAMPLE-TO-
MEMORY IN on the Synclavier.

Poly RAM Management
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Each sound file recorded or loaded into poly RAM remains there as long as there is room
for it. If you run out of poly RAM, sound files that are not part of the current timbre or
are not used in the current sequence are deleted automatically when another sound file is
recalled. Sound files are not deleted when you leave the RTP and go to another software
module, such as the Monitor or TransferMation.

Recording Sound Files
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All sound files in poly RAM are erased whenever the system is turned off.

You can find out the amount of poly RAM available by selecting the Record command
from the Store/Recall menu of the Sound File Editor. The amount of time that appears
after “Time available is” represents the largest contiguous space available for recording
at the currently selected sampling rate.

You can increase the amount of memory available for recording in any of the following
ways—

Reduce the sampling rate.

Use the Collect command in the Store/Recall menu to erase all sound files not used
in the current sequence and timbre. The current sound file remains as part of the
keyboard timbre. All sound files stored on disk remain unaffected. Before selecting
the command, be sure any sound files you want to keep are either stored on disk
(Save command) or recorded in the current sequence (Record command). After
initiating the Collect command, all remaining sound files are collected into a
contiguous area of poly RAM.

Clear all sound files from poly RAM by selecting “Erase all sound files from poly
memory” from the Extra System Commands (E page) display. Type OK and then
press Return. This has no effect on sound files stored on disk. (Itisa good idea to
erase the current sequence before clearing poly RAM.)

If you have a Synclavier 6400, move sound files from poly bin 1 to poly bin 2 by
selecting the Max Time command from the Store/Recall menu. Both bins are
shuffled and as many sound files as will fit into poly bin 2 are moved from
poly bin 1.

For more information on managing poly RAM and using a 64- or 96-voice poly RAM
system, see “Multiple Poly Bin Systems” in the chapter “Recording and Editing from the
Synclavier Keyboard.”
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Storing Sound Files

To store and recall sound files in an organized fashion, you should give each sound file
an identifying name and caption. Use the Sound File Editor to store sound files.

Sound File Names and Captions

Each sound file is identified by a sound file name. This can be the filename that you
assign or one assigned to it automatically in the format—

NEWF[four-digit number]

As you record, the first sound file is named NEWF1000, the second is NEWF1001 and so
forth.

A name that you assign can be a combination of up to eight letters, numbers and symbol

characters. Choose a filename that uniquely identifies the sound. If it is a note, perhaps

include the pitch at which the sound was originally recorded. NED’s timbre libraries use
the following convention:

pitch designator

ABSG#140
Spaces and the following characters cannot be included in the filename—
215, /\<>+=%&*]| @
Each sound file can have a descriptive caption of up to 128 characters stored with it.

m  Select the Caption command in the Display menu to add a caption to a sound file, or
to edit the caption of the current sound file. Although the caption may contain up to
128 characters, only 42 are displayed on this screen.

Saving and Renaming Sound Files
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Use commands in the Store/Recall menu to save and rename sound files in the current
catalog of the current device.

command function

Save Saves the current sound file that is in poly RAM to disk. Enter a valid
sound file name, or if you want to store the sound file with its current
name, press Return without typing anything. Press Return again to save
the file. You can cancel the command by clicking the close box.

Unsave Erases a sound file stored in the current catalog.

Rename Changes the name of the current sound file in memory.

If you assign the name of a sound file already stored in the current catalog, the
stored sound file will be replaced by the current one.

Storing Sound Files
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Viewing and Labeling Sound Files

You can view a graphic representation of a sound file in the sound file window of the
Sound File Editor. You can also place a label or symbol anywhere in a sound file to
mark a specific location or to control the playback

View Commands

View commands allow you to look at the sound file in different formats and to show
portions of the sound file in the sound file window. View commands are available from

the Display menu.

command

Show

Zoom

Search

Center

Left
Print

Lock and Unlock

Dot Mode

Zero ---

function

Relocates the cursor to the time or label you specify. (For more
information, see “Placing a Label” below.)

Allows adjustment of horizontal and vertical scales. Use the up and
down arrow keys to expand and compress the vertical scale. Use
the left and right arrow keys to expand and compress the horizontal
scale. The dialog also allows you to assign a resolution between 1
and 50.

Moves the cursor to the first occurrence of a specified amplitude.
Enter any value between 0 and 5 volts. The polarity of the signal
(positive or negative value) is ignored in the search. For example, if
you enter a value of 3 volts, the cursor moves to an amplitude level
of -3 volts or +3 volts. If you enter a value greater than any
amplitude found in the sound file, the cursor remains at its current
location.

Places the cursor at the center of the sound file window. (If the
cursor is too close to the beginning or end of the file, the command
is ignored.)

Places the cursor at left end of sound file window.

Prints a copy of the screen to a printer connected to the Synclavier
Printer port.

Allows comparison of two mono sound files with the same
sampling rate, one in the upper window and one in the lower
window. (For more information, see “Comparing Sound Files” later
in this chapter.)

Shows one dot for each sample in fine horizontal resolution. In
course resolutions, shows one dot per group of samples. Selecting
the command toggles between Dot Mode and showing the samples
connected by a solid line.

Displays a horizontal line in the middle of each sound file window
that indicates an amplitude of zero volts. A maximum amplitude of
5 volts above and below the zero line is displayed. Selecting the
command toggles the zero line on and off.
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Label Commands

Labels or symbols mark a specific location in the sound file for playback or editing. Some
labels are placed automatically when you record a sound file and some are user-defined.
Label commands are available from the Display menu of the Sound File Editor. (For
more information, see “Setting the Play and Offset Markers” below.)

command symbol
ORIGIN

END

Label <label name>
Mark Start #

Mark End $

Mark Off OFFSET

Symbols

Unlabel

function

Placed automatically. Marks the beginning of the
sound file.

Placed automatically. Marks the end of the sound file.

Places a user-defined label at the current cursor
position. (sSee “Placing a Label” below.)

Places the Mark Start label at the current cursor
position.

Places the Mark End label at the current cursor
position.

Places an offset label in the sound file.

Displays a list of all symbols used in the current sound
file. Select a symbol and press Return to move the
cursor to that symbol.

Removes the specified label. (See “Placing a Label”
below.)

Placing a Label
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A label is a symbolic name assigned to a time value in the sound file. A label is useful
when modifying a sound file or when locating a particular point using the Show

command. To place a label—

1. Move the cursor to the point in the sound file window at which you want the label

placed.

2. Select the Label command from the Display menu.

3. Type up to eight characters into the dialog and press Return. The label is
immediately placed at the cursor location.

To remove a label, select the Unlabel command and press Return twice instead of
entering a label name. This removes the label at the current cursor position. Press any
other Macintosh key to abort the command.

Viewing & Labeling Sound Files
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Setting the Play and Offset Markers

When you record a sound file and play it back, the sound begins at ORIGIN and stops at
END. However, you can mark the sound file so that only a portion of it plays back.

Drag the cursor to the place in the sound file where you want playback to begin.
Select the Mark Start command. The symbol # is placed in the sound file window to
indicate the beginning of playback.

Drag the cursor to the place in the sound file where you want playback to end. Select
the Mark End command. The symbol $ is placed in the sound file window to
indicate where playback stops.

Now when you play the sound file, the sound begins at the Mark Start location and/or
ends at the Mark End location.

You can also mark an offset point, which is used for syncing a time in the sound file to a
time in the sequence.

Place the cursor at the desired offset location and select the Mark Off command.
The label OFFSET marks the offset time.

Comparing Sound Files

You can compare two mono sound files by placing one in the upper sound file window
and the other in the lower sound file window. Both sound files must have the same
sampling rate.

1.

Recall the sound file that you want to place in the lower window. The sound file will
appear in the upper sound file window temporarily.

Select the Lock command from the Display menu. The sound file you recalled in the
previous step now appears in both windows.

Recall a second sound file.

The first sound file remains in the lower window, while the second appears in the
upper window. The sound file in the upper window is the current sound file, which
can be edited, modified or played on the keyboard. The sound file in the lower
window cannot be edited or modified. However, you can play either sound file by
scrubbing in the appropriate window.

To remove the sound file from the bottom window, select the Unlock command. The
sound file in the upper window remains active on the Synclavier keyboard.
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Editing a Sound File

Sound files can be edited in a number of ways: pieces of sound can be cut and pasted
together; portions can be looped for continuous playback; technical adjustments can be
made to clean up signal abnormalities; the duration can be expanded or compressed.

Entering Edit Information

44
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A sound file can be modified in a variety of ways using the Sound File Editor’s Modify
menu.

A) Disploy D) Reverse H) Delete L) Crossfade P) Uolume T) Mix
B) E) Cut 1) Exchange M) Copy ) Hormalize U) Undo
C) Store/Recall | F) Paste J) Combine M) Fill R) Hodulate V) Inwvert
®) Hodify II G) Extract K) Ext Mono 0) Loop 5) Rev Loop W) oC Trim

Some commands, when you select them, operate automatically; there is no dialog to
respond to. Other commands replace the commands list with a dialog that prompts you
to enter additional information. Some messages require more than one value or word.
For example, the Cut command requires the following information—

A) Display Enter begin, end, crossfode times or use the mouse to cut
Oosi S

C) Store/Recall
X) Modify 11

When more than one piece of information is required, separate your responses by
commas. Enter time values as seconds, existing labels, or any combination of times and
labels separated by commas. For example—

1.57,2.31,0.005 OR #,$, 0. 005

Instead of typing your entry, you can scrub in the sound file window to enter a time.

The first edit time is entered after you finish scrubbing the first time. If a second edit
time is required, the cursor becomes a dotted line. Scrub at the second location to enter a
second time. Press the Return key to enter the information.

A) Display Enter begin, end, crossfode times or use the mouse to cut
B) => 1.571 840,2.314 246,0.805 080 [RETURN confirms]|]

C) Store/Recall
X) Hodify 11

When you use the cursor to enter information, each time is accurate to six
decimal places. The first three indicate milliseconds, the second three indicate
microseconds.

To abort a command, click the close box at the top right of the display. n
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Edit Commands

command

Combine

Copy

Crossfade

Cut

DC Trim

Delete

Exchange
Ext Mono

Extract

Fill

Invert

Loop

Mix

Normalize

Paste

Reverse

Rev Loop

TSM

Volume

function

Creates a stereo file from two mono sound files. (See “Mono and Stereo
Modifications” below.)

Copies a specified portion of a sound file to a buffer file. (See “Using
Edit Commands” below.)

Specifies a default crossfade time to be used with all edit commands.
(See “Crossfades” below.)

Removes a defined portion of the sound file and places it in a buffer file.
(See “Using Edit Commands” below.)

Removes DC voltage component (displacement of the sound wave
center above or below 0 volts) from a sound file.

Deletes a specified portion of a sound file. (See “Using Edit Commands”
below.)

Exchanges the right and left channels of a stereo sound file.
Creates a mono sound file from either channel of a stereo sound file.

Creates a new sound file from a specified portion of the current sound
file. (See “Using Edit Commands” below.)

Replaces a specified portion of a sound file with the contents of another
sound file. (See “Using Edit Commands” below.)

Inverts the phase of a sound file. Each positive voltage becomes
negative and each negative voltage becomes positive.

Creates a crossfade loop in a sound file. The sound file ends at the loop
end point. (See “Looping” below.)

Mixes two sound files digitally. (See “Mixing Sound Files” below.)

Rescales the volume of a sound file so that the highest signal level is
5 volts.

Inserts the contents of the buffer or a specified file at the current cursor
position. (See “Using Edit Commands” below.)

Reverses the sound file.

Creates a loop that plays backward and forward between two selected
points. The sound file ends at the loop end point. (See “Looping”
below.)

Compresses or expands the duration of a sound file. (This is the only
command on the Modify Il menu. See “Time Scale Modification”
below.)

Scales the volume of a sound file up or down. (See “Volume Scaling”
below.)
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Edit Buffer

Crossfades

The edit buffer is similar to a Macintosh clipboard. When you use the Cut or Copy
command, the portion of the sound file that was copied or removed is sent to a
temporary storage area in poly RAM: the edit buffer. The contents of the edit buffer can
be inserted or placed in a sound file using the Paste or Fill command.

The edit buffer is a sound file named .editbuf that you can recall to the sound file
window using the Recall command from the Modify menu. However, the edit buffer
cannot be edited unless it is renamed.

Each time you use the Cut or Copy command, the edit buffer is overwritten. Be sure to
save its contents if needed.

A crossfade allows a smooth transition between the parts of the sound file that are
spliced, fading one portion of the sound into the other.

inserted sound file

current sound file

Bl

crossfade
time

The current default crossfade time is displayed at the top of the Sound File Editor. You
can change this default by using the Crossfade command. The minimum allowable
crossfade time, 0 milliseconds, is a butt splice. The maximum crossfade time is 65,535
milliseconds (65.535 seconds). If one of the sound file sections being spliced is shorter
than the crossfade time, a shorter crossfade is created automatically.

m  When the crossfade dialog prompts you for crossfade times, either enter default
times by pressing the Return key or type in beginning and ending times separated by
acomma. If you enter only a beginning crossfade time, it will be used for both the
beginning and ending crossfade time.
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Using Edit Commands

The Cut, Copy, Fill, Extract and Delete commands are used in the same way—

1.
2.
3.

Select an edit command from the Modify menu of the Sound File Editor
Enter the begin, end and crossfade times.
Press the Return key to initiate the edit.

The Copy command copies the marked portion of the file and places it in the edit
buffer. The original file remains intact in poly RAM.

The Cut command removes the marked portion from the current sound file and
places if in the edit buffer. A new current file is created in which the remaining
sections of the sound file are spliced together. The original file remains intact in poly
RAM.

The Fill command creates a new file by replacing the marked portion of the current
sound file with the contents of the file specified in the dialog. If you press Return
without entering the name of a file, the contents of the edit buffer are used. A
crossfade is performed at each end of the fill. The original file remains intact in poly
RAM.

The Extract command creates a new sound file containing only the samples between
the edit points specified in the dialog.

The Delete command removes the marked portion of the current sound file and
creates a new sound file that splices together the remaining portions.

The edit buffer, or any stored sound file, can be pasted into the current file or another file
using the Paste command.

1.
2.

Move the cursor to the point in the sound file at which you want to paste the file.
Select the Paste command from the Modify menu.

Press Return twice to paste the contents of the edit buffer.

or

Enter the name of the sound file to be inserted and a number between 2 and 99
indicating the number of times you want it to be pasted. If you enter only the name
of a sound file, it will be pasted once.

A new current sound file is created. A crossfade is performed at each insertion point.
The original sound file remains intact in poly RAM.

J' To paste more than one copy of the edit buffer, type . edi t buf, (don’t forget
the comma) and the number of copies desired.
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Looping
Normally, if you hold down a key for longer than the original length of a sound file, the
sound stops playing. When you place a loop on a sound file, the looped section is
repeated, and the note is sustained for as long as the key is held.
A crossfade loop fades the end of one looped section into the beginning of the next,
reducing the likelihood of hearing the splice point. Complex sounds, such as string
sections or piano, are effectively looped using the crossfade loop.
LOOP REPEATS FROM
THE START UNTIL KEY
IS RELEASED
>
Crossfade Loop
Loop |
WMMWWUV\,
A reverse loop plays backward and forward between two selected points. It can
sometimes eliminate the need for a long crossfade or for careful location of loop points.
In some sound files, clicks caused by level changes and “pings” caused by harmonic
structure changes can be eliminated.
LOOF REFEATS BACK'W ARD
AMD FORY &R0 UNTIL KEY IS
RELEASED
Loop Loop
Reverse L

z

Use the Loop or Rev Loop command from the Modify menu, to create a new sound file
that contains a crossfade or reverse loop.

1. Determine the start and end points for the loop. You may want to use the Search
command to find similar voltages for both ends of the loop.

2. Select the Loop or Rev Loop command from the Modify menu.

3. Enter the start, end and crossfade times. A new looped file is created. Press a key on
the Synclavier keyboard to hear the result.

If you created a crossfade loop, the sound file plays to the specified end point and
loops to the specified begin point.

If you created a reserve loop, the sound file plays to the selected end time and then
plays backward and forward between the selected begin and end times.
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Volume Scaling

The Volume command from the Modify menu allows you to change the volume of a
sound file. Increase the volume by entering a value between 1 and 30. Decrease the
volume by entering a number between zero and 1. The volume scaling factor is a direct

multiplier—

factor volume change dB
0.5 one-half -6
2 double +6
3 triple +10
10 ten times +20

Mono and Stereo Modifications

You can create a stereo sound file from two mono files, provided that the mono files have
the same sampling rates. One of the sound files must be the current sound file.

1. Recall one of the sound files you want to combine. This is the current sound file.
2. Select the Combine command from the Modify menu.

3. Enter the name of the sound file to be combined with the current file. They can be
placed on left and right channels as shown below.

entry result

, (comma) places the current file on both channels.

J[filename] places the current file on the left, [filename] on the right.
[filename], places [filename] on the left, the current file on the right.

Other commands from the Modify menu include—

m  Create a mono sound file from either the right or left channel of a stereo sound file by
selecting the Ext Mono command and typing L to extract the left channel or R to
extract the right channel.

m  Use the Exchange command to reverse the left and right channels of a stereo sound
file.
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Mixing Sound Files

Sound files can be digitally mixed provided they have the same sampling rates and are
both stereo or both mono. When mixing two sound files, specify the volume relationship
(mix ratio) between the first file and the second file. For example, if you enter a mix ratio
of two, the volume of the second file will be twice the volume of the first file.

Recall one of the sound files you want to mix. This is the first sound file.
Select the Mix command from the Modify menu.

Enter the name of the second sound file and a mix ratio between 0.00 and 30.000.

> W

Press Return to mix the two sound files.

Time Scale Modification

If you have purchased the Time Scale Modification (TSM) module, a DSP70 card has been
installed in your RTP computer that allows you to compress or expand the duration of a
sound file without changing its pitch. (For information on using TSM with cues, see
“Time Scale Modification” in Manual I.)

You can compress or expand the duration of a sound file without changing its pitch using
the Modify Il menu of the Sound File Editor. The length of the modified sound file can
be between half and twice the length of the original sound file. There are three types of
time scale modification —

ONE

Use ONE for most speech or solo instruments, or for sound files containing
percussion. The length of the current sound file is the default value shown in the
field labeled “New Length.”

The default ratio is 1.0000. You can enter any other value between 0.8000 and 1.2000
in the field labeled “Ratio.”

ONE separates the sound file into regular intervals, and cuts (for compression) or
loops (for expansion) at least one segment of the sound file within each interval. You
can control both the interval length and the length of the cut or looped segment.

The value in the field labeled “Max cut” indicates in milliseconds the longest
segment that can be cut or looped from each interval. You can enter any value
between 5.12 and 40.96.

The value in the field labeled “Justification” indicates the relative size of the intervals.
You can set the Justification value to 1, 2, 3 or 4. A value of 4, which separates the
sound file into the longest possible intervals, is appropriate for most sound files,
except those that are clearly rhythmic. We recommend that you begin with a
justification of 4 and adjust if the rhythm of the new sound file is too distorted.
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TWO

Use TWO for most music or sound effects. The length of the current sound file is the
default value shown in the field labeled “New length.” The default ratio is 1.0000.
You can enter any other value between 0.5001 and 1.9999 in the field labeled “Ratio.”

THREE

Use THREE for mixed music or stereo sound files. The length of the current sound
file is the default value shown in the field labeled “New length.” The default ratio is
1.0000. You can enter any other value between 0.5001 and 1.9999 in the field labeled
“Ratio.”

The TSM dialog allows you to specify the desired length of the sound file, or you can
specify the ratio of compression or expansion. If you specify a length, the ratio value
automatically changes to reflect the new length. If you specify a ratio, the length value
automatically changes to reflect the new ratio.

When you modify the time scale of the current sound file, a new sound file is created in
poly RAM. The original sound file remains intact. Time scale modification affects the
entire sound file, even if you have set a mark start or mark end point.

If the current sound file is a stereo file, the new sound file is also a stereo file. If the
current sound file is a mono file, the new sound file is a mono file.

To modify the time scale of a sound file from the Sound File Editor—

Recall the desired sound file.
Select the TSM command on the Modify Il menu.
Set the “Algorithm” switch to ONE, TWO or THREE.

> w e

Change the value in the field labeled “New length” to specify the desired length of
the cue in seconds, or change the value in the “Ratio” field to specify the desired ratio
of compression or expansion.

5. If you selected ONE, enter the desired value into each numeric field in the dialog.
6. Press Return to start time scale modification.

When the process is complete, a new sound file with the specified length is created in
poly RAM with the name NEWF[number]. The new file becomes the current sound
file, and its waveform(s) appears on the screen. If desired, you can name and save
the new sound file.

You can press Enter any time before you press Return to cancel the time scale
modification process. To interrupt the process after you have already pressed Return,
press -Spacebar; the portion of the sound file that has been modified up to that point is
saved as a new sound file.
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Timbres

A timbre consists of up to four partial timbres, which in turn consist of sound files or FM
sounds assigned to different parts of the keyboard. The whole timbre, with its four
layers, can be modified and stored in a timbre file.

Timbre
/ \ 4
partial partial partial partial

timbre 1 timbre 2 timbre 3 timbre 4

| | | |
v v v v

sound files patched to keyboard

Designing a Timbre
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Timbres

When designing a timbre, very complex and dynamic sounds can be created by choosing
different sound files for two or more partial timbres. For example, to strengthen the
attack of a brass instrument, you might put a percussive sound on one of the partial
timbres. Each of these partial timbres can be modified in a variety of ways, including
changing the volume envelope, adding vibrato, portamento or real-time effects.

The whole timbre with its four layers can be further modified by adding effects such as
chorus or repeat/arpeggiate.

When you assign the sounds in the partial timbres to different keys on the keyboard, you
create a keyboard patch, which can be used in many ways. For example, a series of
sound effects could be assigned to specific keys. Different percussion sounds for a drum
kit might make up a keyboard patch for a single partial timbre. A keyboard patch could
also be a series of sampled sounds from a single instrument. For example, to recreate the
sound of a grand piano, a different sampled sound might be placed every two or three
keys.

Depending on whether you are working in music, sound effects or dialog, timbre design
can be used in many ways.
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Timbre Files

‘L

Timbres are stored in a special timbre storage space called a timbre file. A timbre file
consists of up to eight banks with up to eight timbre entries in each bank (a total of 64
timbres).

| TIMBRE DIRECTORY |

1. Use arrows to move cursor, <RETURN: to call up timbre, <EMTER® when done.

2. Select devices with 1,2,3,.... Foly Memory: [Availl [Freel [Bin]
3. Devices:[JIER 2 Fa: [Shuffle] [Collect] [Erosel
— EBAMK 1 —— —— BAMk 2 —— —— BAWK 3 —— —— BANK ¥ —
1. I BBALLSSHOT .46 TUMBA .14 ELEC BRSS! ki
E 2. LIUE ORUMS .37 CROSS STICK @2 COMWGA V36 POPBRSSY (B3
M 3. ELECTRIC EIT .26 TOTOSAM V33 QUINTO .3 BASS W/POP 26
T 4. ELEC KIT #2 .27 DAMGO BELLS .22 TINBALES .42 STEIMBERGER .37
R 5. DRUM MACHIME .31 BOMGO BELLS .18 SHEKERE B¢ SBRSS LAPOP .
W 6, BORUMSSWARE .1 HOOD BLOCKS .1 GAWZA (87 PHASED EBASS .18
*. RIDE CWMBAL1 .47 PERCUSSION .33 TRIAWGLE .42 PHASED SBASS .37
d. RIDE CWMBALZ .45 TABLA .66 TAMBOURIME .49 ACOUSTIC BS 2.47
— BAMKk 5 —— —— BAMk 6 —— —— BAWK 7 —— —— BANK § —
1. PIAMD 3.7 TRUNPET .13 FLUTE .21 LEAD HAMHMOMD (S)
E 2. UIBES .43 TPT SECTIOM1 .76 BRASS/SARES 1.6 SPACE UOICES (5]
W 3. GUITAR 1.3 TPT SECTIOWZ .57 BRSSAJIBES .G RHOCES (5]
T 4. 12 5T GTR 2.3 TROMBOWEY .39 FLUTE/UIBES .63 SYNTH BASS  (5)
R 5. BRHYTHM GUITAR .1 TROMBOMEZ 47 SAR/GUITAR 2,29 SOLO UIOLIN (5)
W a4, STEEL DRUMS .72 BRASS SECTION .6 GUITAR/CLAR 2,25 BIG BELL (5]
T. STRIMGS 1.68 CLARIMET .95 SORUMS/UIBES 1.2 BOO BAMS (5]
g, CELLI 1.7 SAROPHOME .99 HARP GLISS .48 SINME WAUE (5]

Since some timbres take up more space than others, a bank may have fewer
than eight timbres and a timbre file may have fewer than eight banks.

All the timbres in a single timbre file are shown in the Timbre Directory. One timbre file
is located on your system hard disk in the top-level catalog; the storage area of your
system hard disk that is immediately available when you start the system. Other timbre
files can be located in subcatalogs and on floppy disks, one in each storage area. The
Master Timbre/Sequence Storage Disk contains an empty timbre file.

Each timbre file in your system is named .newdata. There can be only one .newdata file
on each subcatalog in your storage system. (For more information on timbre files, see the
chapter “Storage Systems” in the Reference Guide.)

Recalling a Timbre

A timbre is recalled from a timbre file stored on a hard disk or a floppy disk, or from a
track in the current sequence. Sound files that are part of a timbre are loaded into poly
RAM whenever the timbre is recalled.

Go the Timbre Directory and select a timbre from the current timbre file. If the timbre is
stored on another device, type the device number shown near the top of the display.

If the timbre is in another subcatalog, go to the Subcatalog Directory and select the name
of the subcatalog. Return to the Timbre Directory and select the timbre.
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The subcatalog you select becomes the new current catalog. For example, if
you save a sound file, it will be saved to this location.

Panel 4 of the Synclavier keyboard control panel can also be used to recall a timbre—

1. Press and hold BANK and a numbered button. (If the timbre is on a floppy disk,
hold down the LIBRARY button first.) This selects the timbre bank.

2. Press and hold the ENTRY button and a numbered button. This selects the timbre
entry. The selected timbre becomes the current timbre on the keyboard.

To recall a timbre from a track in the current sequence, press and hold the SKT (Select
Keyboard Timbre) button on panel 2 and the appropriate TRACK SELECT button on
panel 3. The selected track timbre becomes the current timbre on the keyboard.

Missing Sound Files

The Missing Sound File display lists all the sound files associated with the keyboard
timbre that cannot be located on the hard disks, the current optical disk or the current
floppy disk.

To load the files located on an optical or floppy disk—

m Insert the floppy or optical disk containing the missing sound files into the drive and
press Return.

The system searches through the storage devices looking for the sound files. The
order in which it searches is: poly RAM, current catalog, WO, W1, optical disk.
When it locates the sound files, they are loaded. If the missing sound files are on
more than one disk, insert the disks until all missing sound files have been loaded
and the display is blank.

Naming a Timbre
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Timbres

Before you store a timbre, you must give it a name. Go to the Main Directory and select
the Name Keyboard Timbre (N page), which is not a display but merely a dialog that
appears on the Main Directory.

N. Home Keyboord Timbre
Enter Home —3>

Type a name up to 16 letters long, and press Return. Spaces and the following characters
cannot be used—

210, /\N<>+=%&*]| @

Another way to name a timbre is to press the TMBRE NAME button on panel 4.
The current timbre name, if any, appears in the keyboard display window with a
blinking cursor is on the first character. Use the control knob to dial in a letter.
Click the TIMBRE NAME button to move to the next character in the name. To
delete a character, turn the control knob all the way to the right.
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Storing a Timbre

R
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Before storing a timbre, make sure there is a timbre file (.newdata) in the destination
subcatalog or floppy disk. If the timbre file is full, or you do not have a timbre file in the
current subcatalog, copy a new timbre file to the appropriate location.

Remember, you can only have one .newdata file on the top level of a system
hard disk or in any subcatalog.

When you store a timbre to a selected place in the timbre file, it replaces any existing
timbre stored in that place. You can store the current timbre in the current catalog using
buttons on the Synclavier keyboard.

1. Press and hold the BANK button and a numbered button on panel 4 to specify the
desired bank into which you want to store the timbre.

2. Press and hold WRITE, ENTRY and a humbered button on panel 4 to specify the
timbre entry into which you want to store the timbre. The timbre is written to that
location.

You must press the keyboard buttons in the correct order or the timbre will not
be stored.

To store the current timbre onto a floppy disk—
1. Insert a formatted floppy disk that includes a .newdata file into floppy drive 0.

2. Press and hold the BANK button and a numbered button on panel 4 to specify the
desired bank into which you want to store the timbre.

3. Press and hold the WRITE, TIMBRE LIBRARY and ENTRY buttons.

4. Continue to hold WRITE and TIMBRE LIBRARY while you press a numbered button
on panel 4 to specify the timbre entry. The timbre is written to the floppy disk.

The following information is stored with the timbre definition—
< Name of the timbre and all sound files contained in the timbre

= Partial timbre modifications, including vibrato, portamento, tremolo (amplitude
modulation), tuning, volume, chorus, final decay, keyboard envelope and real-time
effects

= Whole timbre modifications, such as chorus, arpeggiate, repeat and polyphony
control

< Volume envelope.
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Partial Timbres

Any timbre can have up to four layers of sound. Each layer is called a partial timbre.

Soloing a Partial Timbre

F’*’-RTSIE-*LLEETTIMBRE When you record a sound file, or when you recall one into poly RAM, it is automatically

placed onto the first partial timbre of the current timbre.

You use the PARTIAL TIMBRE SELECT buttons on panel 1 to solo partial timbres. The
buttons have two lighted states that are activated by pressing them: blinking and solid.
When a button is blinking, it is soloed. When it is solid, all partial timbres play. The
button toggles as you press it. You can solo more than one partial timbre by holding
down more than one button at the same time.

Recalling a Partial Timbre

When you recall a timbre, you recall all four partial timbres within that timbre. You can,
however, selectively recall one or more partial timbres from a different timbre. When
you do this, the recalled partial timbre can only be placed on the corresponding partial
timbre of the current timbre. For example, if you recall the second partial timbre of a
stored timbre, it is placed onto the second partial timbre of the current timbre.

To recall a single partial timbre from a stored timbre or sound file—

1. Press and hold the PARTIAL TIMBRE SELECT button that corresponds to the partial
timbre you want to recall.

2. Recall the timbre or sound file that contains the partial timbre you want to recall.
The recalled partial timbre replaces the current partial timbre. The other partial
timbres of the current timbre are unaffected.

You can also recall a partial timbre from a timbre that has been recorded to a track—

1. Press and hold the PARTIAL TIMBRE SELECT button that corresponds to the partial
timbre you want to recall.

2. Press and hold the SKT button on panel 2.

3. Continue to hold down both buttons while you press the TRACK SELECT button of
the track timbre whose partial timbre you want to recall.

The recalled partial timbre replaces the current partial timbre. The other partial
timbres of the current timbre are unaffected.
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Copying a Partial Timbre

A partial timbre can be copied or “bounced” to another partial timbre. This is useful
when, for example, you want to recall partial timbre 1 from a stored timbre, but you do
not want to destroy the first partial timbre currently on the keyboard. If you move the
keyboard partial timbre 1 to partial timbre 2, you can then recall the stored partial timbre
1 without destroying anything.

To bounce a partial timbre—

1. Press BOUNCE on panel 2.

2. Pressthe source PARTIAL TIMBRE SELECT button.

3. Press the destination PARTIAL TIMBRE SELECT button.

The sound files on the destination partial timbre are replaced by the sound files in the
source partial timbre.

Erasing a Partial Timbre

You can erase the sound files from one or more partial timbres.

To erase all of the partial timbres of the current timbre—

m  Press the SKT button on panel 2 and then press the TRACK SELECT button of an
empty track.

To erase an individual partial timbre—

1. Press the SKT button on panel 2.

2. Press and hold the PARTIAL TIMBRE SELECT button you want to erase.
3. Press the TRACK SELECT button of an empty track.
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Keyboard Patch

A keyboard patch is a group of sound files on a single partial timbre assigned to a region
of the keyboard.

Patch List

A patch list is a list of all sound files in a partial timbre and their keyboard assignments.
The patch list is displayed or created using the Patch Display (I page). If the partial
timbre contains sound files, the patch list is displayed.

m  Press the spacebar to display each partial timbre in turn.

Keyboord Timbre: 1-7-4: "FLUTE/VIBES .69" <— timbrename

Current Cotolog: WO: and location
partial .

timbre —» Partial # 1: Memory Left: 3.8 Megabytes
number File Stort End Volume Tronspose Tuning Totol Length Loop Length
1. VIBEGIL C2 A2 166.6 B2 0.60 0.006 000 0.606 000
2. VIBEDZL B2 F3 85.0 D3 0.00 0.000 00O 0.600 000
iff;a"tghﬁl'igi 3. VIBEA2L F#3 4 160.8@ A3 6.60 0.000 060  0.600 000
4. VIBEE3L C#4 G+ 1686.6 Et 0.60 0.600 006 0.600 000
5. VIBEB3L G#4 Db 80.0 B4 0.60 0.000 000 0.600 000
6. VUIBEE4L D#5 C6 168.8 ES 0.00 0.000 00O 0.600 000

At the top of the list is the location of the keyboard timbre in the timbre file
(1-BANK #-ENTRY #), followed by the timbre name. The patch list contains the
following information about each sound file—

File Sound file name.

Start Lowest note to which the sound file is assigned.

End Highest note to which the sound file is assigned.

Volume Playback volume of the sound file.

Transpose Key to which the original pitch is assigned. If no value is displayed, the

original pitch sounds on A3.
Tuning Tuning factor. Used to tune each sound file in the keyboard patch.
Total Length The play length of a sound file.
Loop Length The play length for a keyboard loop.
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Creating a Patch List
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A patch list is built by recalling the sound files that you want in the patch to the Patch
Display.

To add a sound file to a patch list—
1. Make sure the cursor is at the patch list entry where you want to add a sound file.

Use the arrows keys if you need to move the cursor.

2. Press Control-C to go to the Sound File Directory. Select the desired sound file and
press Return. This will add the sound file to the patch list and return you to the
Patch Display automatically.

If you know the name of the sound file, you can type its name in the Patch
Display instead of going to the Sound File Directory.

3. To add another entry to the end of a patch list, press the down arrow key.

4. Repeat these steps to add as many sound files as you want to the partial timbre patch

list.

Ten entries can be displayed at once. When you add the eleventh, the first five scroll up,
leaving room for additional entries.

To edit a patch list—
m  Type a new sound file name.

m  Toinsertasound file into the list, place the cursor in the patch list and press the
hyphen key. This adds a new line before the current line.

m  To delete a sound file from the patch list, move the cursor to the sound file name and
press the Delete key.

The trackball does not operate on the Patch Display. You must use the
Macintosh keyboard arrow keys to move the cursor around the display.

Assigning Sound Files to the Keyboard

You assign a sound file to an area of the Synclavier keyboard by typing key names in the
Start and End columns. Key names are indicated by a pitch letter followed by an octave
number. The lowest key on the keyboard, at the far left, is A0. The lowest C on the
keyboard is C1. The highest key, at the far right, is C7.

FMIDDLE
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Black keys are designated by placing a sharp sign (#) after the pitch name to designate
the note to the right of the pitch letter. Flats are not used. For example, the black note
between A and B is A# rather than B flat.

To enter a key name, arrow to the Start (or End) column and type a key name. This is the
lowest (or highest) key to which the sound file is assigned.

Only one sound file in a partial timbre may be assigned to a key. If two different
sound files are assighed to the same key, an error message appears. This is easily
remedied by changing the Start or End key in the patch list.

Transposing Sound Files

Regardless of the pitch at which a sound file was recorded, its original pitch normally
sounds only when you play A3. The original sound is distorted as you play higher or
lower on the keyboard. You can, however, place the original pitch on any key on the
keyboard by moving the cursor to the Transpose column and typing the key name of the
key on which you want the original pitch to sound.

The following examples show different transpose settings.

recorded transpose key
pitch setting pressed sound
C3 — A3 C3
C3 — C3 E2
C3 C3 C3 C3
unknown D3 D3 recorded pitch

Adjusting Volume and Tuning

62

Each sound file in a patch list has an independent volume setting. You can adjust the
relative volume of the individual sound files in the patch list by changing the Volume
setting in the patch list. Type any value between 0.0 and 100.0 percent.

Each sound file can be tuned independently. Move the cursor to the Tuning column and
enter any value between -48.00 and +48.00 semitones, or adjust the tuning by ear by
pressing a key on the Synclavier keyboard while turning the control knob.

Keyboard Patch
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Keyboard Looping
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Normally if you hold down a key for longer than the original length of the sound file, the
sound stops. When you place a loop on a sound file, however, the looped section repeats
for as long as the key is held.

When the sound file is looped as part of the partial timbre, it is called a keyboard loop.
It becomes part of the timbre definition, and as such does not affect the sound file when it
is not part of the timbre. A keyboard loop is best for sounds with a fairly even harmonic
structure on the decay, such as a single brass instrument.

A keyboard loop is not part of the sound file definition, it is part of the timbre
definition. To preserve a keyboard loop, the sound file must be saved as part of
a timbre.

Two parameters are set in the keyboard loop. The Total Length is measured from the
start of the file to the start of the “loop back.” The Loop Length is the section of the
sound file to be repeated. These lengths are measured in seconds.

There are two ways to add a keyboard loop to a sound file in a patch list: the Synclavier
keyboard button panel and the Patch Display.

The Patch Display is primarily useful for adding a keyboard loop to a sound file that has
already been placed in a patch list—

m  Locate the sound file in the patch list and enter the Total Length and the Loop Length
in seconds.

The Synclavier button panel is useful for adding a keyboard loop to any sound file on the
keyboard. To add a keyboard loop using button panel 1—

1. Recall a sound file to the keyboard.
2. Press HARMONIC CONTROL 1 and turn the control knob to set the Total Length.
3. Press HARMONIC CONTROL 2 and turn the control knob to set the Loop Length.

When you press a key, the sound file will play for the specified Total Length time,
and then loop back as specified by the loop length.

Keyboard loops are most effective when the amplitude at the loop start pint matches the
amplitude at the look end point. If you do not know exactly where to place a loop, the
system can search for the best location. There are two types of automatic searches—
overall and local.

When you perform an overall search, the computer checks the pitch, volume, and
harmonic components of a portion of the sound file directly preceding the end loop
point. It looks through the entire sound file for an area that most closely matches this
portion and automatically sets the loop length so that the loop starts at that point.
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To perform an overall search—

1. Recall a sound file to the keyboard.
2. Press HARMONIC CONTROL 1 and turn the control knob to set the Total Length.
3. Press and hold HARMONIC CONTROL 2 and press the START button.

When the search is complete, a keyboard loop is placed on the sound file and the
keyboard display window indicates the “MATCH” percentage, or accuracy of the
match of the end loop point with the start loop point. To see the Loop Length, press
HARMONIC CONTROL 2.

To stop a search at any time, press the STOP button. The program will select the best
match of samples surveyed up to that point.

The time required for an overall search varies depending on the length of the file
and the total length setting.

‘L

An overall search produces good loop results about 50% of the time. If the Loop Length
selected is too short, the Loop Length itself can become an audible frequency. If you
select a slightly different Total Length and try another overall search, a completely
different Loop Length may be found.

When you perform a local search, the computer checks the portions of the sound file
near the start and end points already specified and resets both the Total Length and Loop
Length for the best possible loop point.

To perform a local search—
1. Seta Total Length and rough Loop Length, as described above.

2. Pressthe HARMONIC CONTROL 1 and CONTINUE buttons to start the local
search, which should take less than a second. As a result, the start loop and end loop
points will be shifted slightly to improve the match. You may want to repeat the
local search to find the best Loop Length.

The window length is the number of actual samples that are compared during the
search. With a window length of ten, for example, an overall search tries to match the ten
samples immediately preceding the loop end point with a section of ten adjacent
samples. A local search tries to match the ten samples near both the start and end loop
points with a section of ten adjacent samples; both points would then be shifted to the
best match found.

To set the window length—
m  Press HARMONIC CONTROL 3 and dial in a value up to 250 with the control knob.

The larger the window setting, the more time a search takes. In addition, samples
may match harmonically, but vary in volume, which results in an audible loop point.
If the window length is too small, the volume may match, but there are not enough
samples to create an accurate harmonic match. The loop may be so short that the
loop frequency itself is audible. A window length of 3-10 samples is generally a good
choice.
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Keyboard Display

The Patch Display can be toggled to display a detailed list of every note on the Synclavier
keyboard and its sound file assignment. Press the Return key to toggle between the
patch list and the keyboard display.

Timbre: 1-6-2: "TPT SECTIOWI .76" Selected Partiaol: #2
"PATCH" Display
I OCTAVE |
PITCH C@ -HB8 C1 - Bl C2-B2 C3-B3 C+-B4 C5-B5 C6-B6

C : HI9 HIB HIS
C# : HI9 HIB HIS
n . HTO HTR HTS

To view any of the partial timbres, either press a PARTIAL TIMBRE SELECT button, or
type 1, 2, 3 or 4 on the Macintosh keyboard. Assignments cannot be edited on the
keyboard display.
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Modifying Partial Timbres

There are many ways you can alter a selected partial timbre, including changing the

volume envelope or

adding vibrato or portamento. When altering a partial timbre

keyboard patch, all sound files in the patch are altered as part of the timbre.

Volume Envelope

66

A volume envelope allows you to alter four time segments and two volume levels of the

selected partial timbre.
Delay Attack Initial Sustain Final
Decay Decay
. peak 1 1 ,
100 : level H H !
i . ' i
1 1 . 1 1
o ! ! sustain ! '
g ! 1 level 1
o ' | —
> . ' .
1 ] [
1 1 1
] 1 1
0 . :

Duration of Key Depression

The volume envelope buttons are located on panel 1 of the Synclavier keyboard. To
program a parameter, select a partial timbre and then press the appropriate volume
envelope button. Numeric settings appear in the keyboard display window.

DELAY

ATTACK

INITIAL DECAY

FINAL DECAY

PEAK

SUSTAIN
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Time from key depression to beginning of sound. If you want the
sound to start after the key is depressed, turn the control knob to
select a time between 0-30,000 milliseconds.

Time from beginning of sound to peak volume. Turn the control
knob to select an interval between 0-15,000 milliseconds.

Time from peak volume to beginning of sustain volume. Turn the
control knob to enter a time interval between 0-30,000 milliseconds.

Time from key release to end of sound. Turn the control knob to
enter a time interval between 0-30,000 milliseconds.

Relative volume at the change from attack to initial decay. Press this
button and then turn the control knob to set a level between
0-100.0%. Zero is no volume and 100.0 is maximum volume.

Relative volume from end of initial decay to key release. Press this
button and then turn the control knob to set a volume level between
0-100.0%. Zero is no volume and 100.0 is maximum volume.

When you program a volume envelope for a keyboard patch partial timbre, the
new volume envelope must stay within the volume limits of the original sound

files in the timbre. That means you can lower the volume of any segment of the
partial timbre but you cannot raise it.
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Vibrato

A partial timbre can be enhanced by adding vibrato, which changes the pitch of a note as
it is being played. The vibrato buttons are located on panel 5 of the Synclavier keyboard.
To program the parameter, select a partial timbre and then press the button. Numeric
settings appear in the keyboard display window.

VIBRATO WAVE The shape of the pitch change. Press repeatedly or turn the
control knob to select one of twelve vibrato wave shapes. (See
the list below.)

VIBRATO RATE Turn the control knob to select a vibrato repeat rate between 0.00
and 50.00 Hz.

VIBRATO DEPTH Turn the control knob to select a vibrato depth between 0.00 and
24.00 semitones.

VIBRATO ATTACK Turn the control knob to select a vibrato attack delay between
zero and +10,000 milliseconds (10 seconds). The vibrato
increases gradually to its full depth from the beginning of the
note to the selected attack time.

Random wave shapes generate a continuous and random set of pitches changing at a rate
determined by the vibrato rate setting and falling within the range determined by the
vibrato depth setting. When using either of the random wave settings, you will probably
never get exactly the same wave shape twice.

There are six vibrato wave shapes, each of which can be inverted:

vibrato wave vibrato wave
wave # shape wave # shape
1 sine 7 triangle2
2 triangle 8 ramp2
3 ramp 9 inverted ramp?2
4 inverted ramp 10 square2
5 square 11 random
6 sine2 12 random?

Normally when vibrato is added to a partial timbre, the pitch of each note fluctuates an
equal amount above and below the pitch of the key pressed. The total range in semitones
is determined by the depth setting. Press the following buttons to change this
fluctuation.

VIBRATO BIAS Create a vibrato in which the pitch fluctuates entirely above
the key pressed. Press VIBRATO BIAS and play a note. Asa
result, the lowest point of pitch fluctuation is the
pitch of the note played. The highest point is twice the
number of semitones set for the vibrato depth.
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VIBRATO INVERT

VIBRATO QUANTIZE

Create a vibrato in which the pitch fluctuation is entirely
below the key pressed. Press VIBRATO BIAS, press
VIBRATO INVERT and then play a note. As a result, the
highest point of pitch fluctuation is the pitch of the note
played. The lowest point is twice the number of semitones set
for the vibrato depth.

The fluctuations produced by a vibrato are normally smooth
and gradual. However, you can quantize, or step, in semitone
intervals the fluctuations in pitch. After you set the vibrato
wave, depth and rate, turn on the quantize function by
pressing VIBRATO QUANTIZE.

You can combine quantized vibrato with the repeat and/or arpeggiate functions for
special effects. Use the buttons on panel 4.

1. Pressthe REPEAT, ARPEGGIATE and RATE and dial in a rate that is integrally
related to, but not necessarily identical with, the vibrato rate.

2. Press REPEAT and play a note.

As you hold down the note, it is repeated at the repeat rate. Each repeat sounds on
different quantized pitches according to where in the vibrato cycle each repeated

note occurs.

3. Press ARPEGGIATE and play a chord.

As you hold down the keys, notes are repeatedly arpeggiated. The notes occur at

varying pitches accordi

ng to where they occur in the vibrato cycle.

Portamento
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When portamento is added

to a partial timbre, each note glides to the next. You can

program the pitch curve of the glide to be either linear or logarithmic using the
portamento buttons on panel 5. To program a parameter, select a partial timbre and then
press the appropriate button. Numeric settings appear in the keyboard display window.

PORTAMENTO ON/OFF
PORTAMENTO MODE

PORTAMENTO RATE

Modifying Partial Timbres

Toggles the portamento function on and off.

When not lit the pitch curve is linear. Press and light to
turn on the logarithmic mode.

Turn the control knob to select a portamento rate between
0.000 and 1.000. At a rate of 0.000, it takes almost a minute
for a pitch to travel from one pitch to another. At a rate of
1.000, the change between one pitch and the next is
instantaneous.
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Amplitude Modulation

Amplitude modulation, or tremolo, can be thought of as a periodic variation in volume.
There are four tremolo modes: two attack modes and two decay modes. The attack
modes cause a hote to begin at a low volume point and rise to full volume. The note then
continues to fluctuate at a specified rate. The decay modes cause a note to begin at full
volume and decrease to a specified low point.

Both attack and decay modes can be either synchronous or independent. In the
synchronous mode, all notes are loud or soft at the same moment. In the independent
mode, each note begins its cycle independently.

The STEREO buttons on panel 5 is used to control amplitude modulation. To program a
parameter, select a partial timbre and then press the appropriate button. Numeric
settings appear in the keyboard display window.

STEREO RATE Turn the control knob to select a rate between 0.0 and 6.0 Hz.

STEREO DEPTH Turn the control knob to select a tremolo depth between 0 and
50. With a depth setting of zero, the amplitude does not
fluctuate at all. When a depth setting of 50, the amplitude
fluctuates between the full programmed volume level and zero.

STEREO WAVE Turn the control knob (or press the button repeatedly) to select
one of the four modes used for amplitude modulation (21-24).

mode function

21-SYNC AM ATTACK Synchronous attack mode. Tremolo begins at lowest
volume point and rises to full volume. Modulation is
synchronized for all notes.

22-IND AM ATTACK Independent attack mode. Tremolo begins at lowest
volume point and rises to full volume. Modulation is
independent for each note.

23-SYNC AM DECAY Synchronous decay mode. Tremolo begins at full
volume and falls to lowest point. Modulation is
synchronized for all notes.

24-IND AM DECAY Independent decay mode. Tremolo begins at full
volume and falls to lowest point. Modulation is
independent for all notes.

J' When using amplitude modulation settings, the other modes of the STEREO
WAVE button are not available to the selected partial timbre. See “Stereo” later
in this section.
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Tuning and Volume

Each partial timbre can be individually tuned to create harmonic relationships, phase
shifts or complex modulations.

m  Press the PARTIAL TUNING button on panel 1 and turn the control knob to select
a new pitch from 0.0 to 1760.0 in 0.1 Hz increments. (A above middle C is 440.0 Hz.)

OR

m  Press the PARTIAL TUNING button repeatedly to increment the partial tuning in
octaves—
110.0 220.0 440.0 880.0 1760.0

You can establish constant tuning for a partial timbre by dialing in a negative number. In
this case, the partial timbre sounds at the pitch specified to the right of the minus sign,
regardless of what note is played. This makes it possible to create effects such as a guitar
timbre that has the constant pitch on one partial timbre while the remaining partial
timbres contain the pitched guitar sound.

m  To adjust the volume of each partial timbre, press the PARTIAL VOLUME button
on panel 1 and turn the control knob to select a number between zero and 100
percent.

Chorus Effects

The partial chorus function adds another voice to the selected partial timbre without
affecting the other partial timbres. The additional voice can then be tuned to any desired
relationship with the selected partial timbre.

m  To adjust the chorus effect, press the PARTIAL CHORUS button on panel 5 and
turn the control knob to select a partial chorus setting between 0.000 and 10.000. The
number dialed in establishes the interval above or below the pitch of the selected
partial timbre, with 1.000 representing a unison.

partial chorus relationship of added voice
setting to fundamental frequency
0.125 three octaves below
0.250 two octaves below
0.500 one octave below
1.000 unison
1.125 major third above
1.500 perfect fifth above
2.000 second harmonic (one octave above)
3.000 third harmonic (one octave plus a perfect fifth above)
4.000 fourth harmonic (two octaves above)
5.000 fifth harmonic (two octaves plus a major third above)
6.000 sixth harmonic (two octaves plus a perfect fifth above)
7.000 seventh harmonic (two octaves plus a minor seventh above)
8.000 eighth harmonic (three octaves above)
9.000 ninth harmonic (three octaves plus a major second above)
10.000 tenth harmonic (three octaves plus a major third above)
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You can achieve phase shift effects (flanging) by tuning the added voice to a
pitch very near the fundamental or an octave harmonic or subharmonic. A
setting of 1.003 or 0.998 results in different tones that are below the audible
range, but are noticeable as phase shift in the upper harmonics of the tone.

You can reinforce the existing harmonics of a tone by dialing in an integer as shown in
the table above. Inharmonic frequencies producing harsh effects can be added by
selecting certain non-integer values.

Keyboard Envelope

A keyboard envelope controls the volume of a partial timbre across the keyboard. It
allows you to define an area of the keyboard where the partial timbre fades in from left to
right and an area on the right where it fades out from right to left. In between, the partial
timbre plays at full volume.

fade in full volume fade out

volume

keyboard

To set the fade in area—

1. Press and hold the LEFT KEYBOARD ENVELOPE button on panel 4 while you
play the key that defines the fade in point, meaning the left boundary of full volume.

2. Continue pressing LEFT KEYBOARD ENVELOPE while you play another key to the
left of the previously played key that defines the beginning of the fade in area. (If no
fade area is desired, play the key you played in step 1 again.)

Notes within the defined fade area become louder from left to right. Notes to the left
of the fade area do not sound. The display window shows the length of the fade area
computed in half steps.

To set the fade out area—

1. Press and hold the RIGHT KEYBOARD ENVELOPE button on panel 4 while you
play the key that defines the beginning of the fade out area.

2. Continue pressing RIGHT KEYBOARD ENVELOPE while you play another key to
the right of the previously played key that defines the end of the fade out area. (If no
fade area is desired, play the key you played in step 1 again.)

Notes within the defined fade area become louder from right to left. Notes to the
right of the fade area do not sound. The display window shows the length of the
fade area computed in half steps.

You can use the control knob to change a number once the keyboard key is

pressed. Numbers outside the keyboard range can be selected, allowing
keyboard envelopes to be defined for MIDI controllers with larger keyboards.

Modifying Partial Timbres 71



| Chapter 3

Stereo

The stereo parameter allows you to place each partial timbre on any of 100 locations
between left and right speakers. Thus a timbre with four partial timbres can sound as if it
comes from four different locations. When a sequence is played, sounds can seem to
come from as many locations as you have voices in your Synclavier.

You can also program each partial timbre so that it “moves around” during live
performances or playback of recorded sequences. A partial timbre can move according
to key location or it can automatically pan from speaker to speaker during held notes.
One partial timbre can move from left to right while others move in reverse direction.
Or, by properly positioning the speakers, some sounds can move toward the listener
while others recede.

Stereo settings for each partial timbre are saved when you store a timbre on disk. This
information is also recorded when you create a sequence. You can also add stereo to old
recorded sequences simply by adding stereo to the timbres in them.

By default, each partial timbre has a static stereo image that makes each note appear to
come from the center of the stereo image. You can alter the stereo position using buttons
on panel 5. The pattern, range and center point of the stereo movement are programmed
by the buttons STEREO WAVE, STEREO DEPTH and STEREO PAN. The actual
movement is determined by either the specific keys played (modes 3 and 4) or the
STEREO RATE button (modes 5, 6, 9, 10, 11, 12, 15, 16, 17, 18).

To program a parameter, select a partial timbre and then press the appropriate button.
Settings appear in the keyboard display window.

STEREO PAN Turn the control knob to change the center position between -50
(full left) and +50 (full right). Reset the panning center to zero by
pressing the button twice.

STEREO RATE Turn the control knob to select a rate between 0.0 and 6.0 Hz.

STEREO DEPTH Turn the control knob to select a depth between 0 and 50. With a
depth setting of zero, the amplitude does not fluctuate at all.
When a depth setting of 50, the amplitude fluctuates between the
full programmed volume level and zero.

STEREO WAVE Turn the control knob (or press the button repeatedly) to select a
panning mode. (See below.)

mode function

0-STATIONARY Output of the partial timbre remains at defined stereo
position. (Default mode)

3-KEYBOARD Stereo positions mapped to keys on the keyboard. With

default center position of 0 and depth setting of 50, center
point is at F# above middle C, with lower notes to the
right and higher ones to the left. Both center point and
depth settings can be adjusted.
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4-KEYBOARD INV
5-ALTERNATE

6-ALTERNATE INV
9-SYNC SINE

10-SYNC SINE INV
11-SYNC SQR

12-SYNC SQR-INV
15-IND SINE

16-IND SINE INV
17-IND SQR

18-IND SQR INV
19-RANDOM

20-RANDOM INV

Mirror image of mode 3.

Automatic ping-pong panning between right and left ends
of panning range with each new note triggering a move to
the opposite side.

Mirror image of mode 5.

Synchronous automatic panning using a sine wave.
Panning moves from center point to the right and then to
the left.

Mirror image of mode 9.

Synchronous automatic panning using a square wave.
Panning moves from center point to the right and then to
the left.

Mirror image of mode 11.

Independent automatic panning using a sine wave.
Panning moves from center point to the right and then to
the left.

Mirror image of mode 15.

Independent automatic panning using a square wave.
Panning moves from center point to the right and then to
the left.

Mirror image of mode 17.

Random panning with each note placed at a random
position within the panning range.

Mirror image of Mode 19.

STEREO WAVE modes 21-24 are explained under “Amplitude Modulation.”

In the automatic panning modes, the output moves around in the stereo image at a set
rate while you hold down a key. Modes 9-12 are synchronous modes. All notes in a
chord are panned together. As you add each new note, the panning picks up at the point
in the panning cycle where panning for the previous note stopped. Modes 15-18 are
independent modes. The panning of each note starts at the beginning of the panning
cycle, at the designated center point for the partial timbre.

A STEREO DEPTH rate of 0 has no automatic panning.
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Real-Time Effects

When you add real-time effects (RTESs) to a timbre, you can control its dynamics and
many other qualities by the way you play on the Synclavier keyboard.

RTE Controllers

Depending on which RTE controller you select and how you use it, you can change the
characteristic sound of the keyboard timbre and its dynamics on a note-by-note basis.
Each note can have a quality and/or loudness slightly different from the one preceding it
and the one following it.

The Synclavier offers eight expression input controllers on panel 5, some of which are
external, such as the pedal, and some of which are internal, such as the velocity
controllers. Each can be patched to one or more partial timbre and one or more different
timbre parameters.

T EXPRESSION INFUTS .

WEL. PRESSURE FED. 1 PED. zMOD WHEEL RIE. KEYERD. BREATH

CN. CONTROL

expression input

controller button timbre is affected by

VELOCITY speed of keyboard attack

PRESSURE amount of after-attack pressure

PEDAL 1 & PEDAL 2 how far pedal is depressed

MOD WHEEL rotation of the inside wheel at left of Synclavier keyboard

RIBBON position of finger on the black velvet ribbon just above the
keyboard

BREATH CONTROLLER amount of breath blown into a breath controller

KEYBOARD C.V. where you are playing on the keyboard (playing higher
notes produces more control voltage)
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Timbre Parameters

Most timbre parameters available for RTE patching are marked by a small white dot to
the right of the button. These include:

Panel 1:

< VOLUME ENVELOPE and HARMONIC ENVELOPE buttons
< PARTIAL TUNING and PARTIAL VOLUME

< FMRATIO

Panel 2:

< TRACKVOLUME

Panel 4:

< REPEAT, ARPEGGIATE and RATE

< DYNAMIC ENVELOPE

Panel 5:

< PARTIAL CHORUS

< VIBRATO RATE, DEPTH, MOD DEPTH and ATTACK/DECAY
e STEREO RATE, DEPTH and PAN

e« PORTAMENTO RATE

Adding Real-Time Effects

To add real-time effects, you have to make a patch between the expression input
controller and the timbre parameter that is going to control and the selected partial
timbre(s). By default all partial timbres are selected.

1. Press and hold one of the EXPRESSION INPUTS buttons on panel 5.
2. Pressone or more PARTIAL TIMBRE SELECT buttons on panel 1.

This selects the partial timbre(s) where you want the RTE routed. If you press more
than one partial timbre button, the same setting will be applied to all selected
partials.

3. Continue holding the EXPRESSION INPUTS button while you select the desired
timbre parameter button. (Press twice to add an RTE in the inverted mode.)
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When you hold down an expression input button, the partial timbre(s) to which a
controller is patched blinks. It remains blinking as long as the controller button is lit. The
timbre parameters to which that controller is patched light up and remain lighted for as
long as the controller button is held.

J' Many timbres are already programmed for real-time effects. When you recall a
timbre, any controller that has already been patched to that timbre parameter

lights up.

button state meaning

On steady Expression input is already routed to the parameter in the normal
fashion.

Blinking Expression input is routed to the parameter in the inverted mode.

Flickering The parameter is available for patching.

When you add an RTE in the inverted mode, the relationship between the expression
input controller and the timbre parameter is reversed. For example, if you patch
PRESSURE to PARTIAL VOLUME in the normal fashion, then the harder you press the
keys, the louder the sound plays. If you patch PRESSURE to PARTIAL VOLUME in the
inverted fashion, the harder you press the keys, the softer the sound plays.

Removing Real-Time Effects

To remove an RTE you must clear the patch between the expression inputs, the timbre
parameters and/or the partial timbres. Removing an RTE patch from a timbre parameter
does not affect the parameter setting.

m  Toremove asingle RTE patch, press and hold the CLEAR button on panel 5 while
pressing the appropriate EXPRESSION INPUTS button, the PARTIAL TIMBRE
SELECT button and/or the timbre parameter button that marks the patch you want
to remove.

m  To remove all expression input routings simultaneously, press and hold the CLEAR
button while running a finger across all eight EXPRESSION INPUTS buttons. As a
result, the expression input routings are cleared, but the routings between the partial
timbres and timbre parameters are still in effect.

m  To remove all partial timbre routings, press and hold the CLEAR button while
pressing one at a time all four PARTIAL TIMBRE SELECT buttons. As a result, all
partial timbres are cleared of RTE routings. Routings between expression inputs and
timbre parameters remain in place, but are not assigned to the timbre.

Velocity
When you patch velocity to a partial timbre and one or more timbre parameters, the
dynamics or expression of the timbre varies according to the velocity with which each
key is depressed. For example, if velocity is patched to partial volume, the volume
depends on the velocity of the keystroke.
i L . -
‘* The velocity input is measured only at the beginning of the note.
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When you patch velocity to a timbre parameter, you can adjust both the dynamic range
available for control and the keyboard response to your touch. These two settings
interact to give you the widest possible range of keyboard response to velocity real-time
effects. The two keyboard buttons used to control velocity are VELOCITY
SENSITIVITY and VELOCITY RESPONSE on panel 5.

If you want to reach maximum value with a moderate touch over a large range of
possible values, set the SENSITIVITY to its highest setting and RESPONSE to a medium
setting. If you want a smaller range of dynamics with maximum value reached only with
a very heavy touch, set SENSITIVITY to a mid-range setting and RESPONSE to its
minimum.

To set velocity sensitivity, first make sure velocity has been patched to the desired partial
timbre and timbre parameter, then—

m  Press SENSITIVITY and turn the control knob to select a setting between 0 and 100
percent. A setting of 100 gives you the most dynamic range, and zero gives you
none.

For example, if the keyboard has velocity patched to partial volume and velocity
sensitivity is set to 100 (the default setting), a full range of volume is available when you
play. When your touch is very soft, you get almost no volume; when you play rapidly,
you get the full volume programmed for the timbre. On the other hand, if velocity
sensitivity is set to 0, you get the full programmed volume of the timbre no matter how
slowly or quickly the keys are played. With a setting of 0, there is no dynamic range.

To set velocity response, first make sure velocity has been patched to the desired partial
timbre and timbre parameter, then—

m  Press RESPONSE and turn the control knob to select a setting between 0 and 9, or
press the button repeatedly to step through the values. The default setting is 3,
which corresponds to an average response or moderate touch. Higher numbers
correspond to a lighter touch, while lower humbers correspond to a heavier touch.

For example, if the keyboard timbre has velocity patched to partial volume and you dial
in a velocity response of 9, a fairly light touch can be used to achieve full volume. If, on
the other hand, you dial in a setting of 0, you will need a very heavy touch to play full
volume.

You should experiment with the response and sensitivity settings on a variety of timbres
to become familiar with the possible settings that suit your playing style.
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Pressure

Pedal Inputs

78
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When you patch pressure to a timbre parameter, the dynamics or expression of the
timbre varies according to how much pressure is applied to the bottom of the keystroke.
For example, if pressure is patched to partial volume, the volume of the notes increases as
you increase pressure on the key.

Although any expression input can be patched to any timbre parameter, some
patches make little sense. For example, you usually hear no effect if you patch
pressure to the volume envelope attack, since by the time you are able to vary
the pressure of a key, the attack of the timbre has already sounded.

When you first press the PRESSURE button on panel 5, a value of 0.200 is shown in the
display window. This is the default setting for the pressure response filter used to
smooth out the effects of abrupt pressure changes on the real-time effects. Using the
control knob, you can select settings between 0.000 and 1.000. A value of 1.000 gives the
fastest possible response with any variation in pressure, creating an instant change in the
timbre parameter patched to pressure. Lower settings give slower responses, making
possible very long crescendos or diminuendos or very slow pitch changes. With a setting
of 0.000, pressure changes do not affect RTEs.

There are two pedal input jacks on the back panel of the Synclavier keyboard unit.
Although either one can be used for any kind of RTE, you may find it convenient to
reserve one pedal for overall volume control and the other for other kinds of real-time
changes in the partial timbres.

When the PEDAL 1 button on panel 5 is patched to partial volume in the normal fashion
and is not turned on, no sound is heard. There is no sound while the pedal is in the “up”
position. Maximum volume is reached when the pedal is pushed all the way down.
Volume changes occur instantly, even in the middle of a note. With the first pedal
reserved for volume changes, the PEDAL 2 button on panel 5 can be patched to other
RTEs.

In general, pedals are most effective when patched to timbre parameters that occur
throughout the duration of a note, such as partial tuning (for pitch bending or sliding
notes), vibrato rate or vibrato depth or stereo rate. Patching a pedal to FM parameters,
such as harmonic sustain or FM ratio, is also effective, as is patching it to
repeat/arpeggiate rate.

If the patching is done in the normal fashion, all selected RTEs are set at 0. As you press
the pedal down, the values for the selected RTE parameters gradually increase. When
the pedal is all the way down, the RTE parameters equal the time intervals or levels
originally set for the timbre parameter.

Real-Time Effects



